Table of Contents

INTRODUCTION .................................................................................................................. 8

ABOUT THIS GUIDE ............................................................................................................. 9
ADDITIONAL HELP ............................................................................................................. 9
NoodleBib overview tour ................................................................................................... 9
NoodleBib screencasts ....................................................................................................... 9
NoodleBib PowerPoints ..................................................................................................... 9
NoodleTools Knowledge Base .......................................................................................... 9
NoodleTools Support ........................................................................................................ 10
NoodleBib “Have a Question?” links .............................................................................. 10
NoodleTools.info ............................................................................................................... 10
Contacting NoodleTools ................................................................................................. 10

CHAPTER 1: REQUIREMENTS AND OPTIONS .......................................................... 11

SYSTEM REQUIREMENTS ............................................................................................ 11
Browser requirements ..................................................................................................... 11
Minimum requirements ................................................................................................... 11
Browser settings ............................................................................................................. 11
NoodleBib versions ......................................................................................................... 11
NoodleBib MLA Starter (free) ........................................................................................ 11
NoodleBib Express (free) ............................................................................................... 12
NoodleBib (Subscription Version) ................................................................................ 12
Integration with Pearson’s MyCompLab ......................................................................... 13

VERSION COMPARISON CHART .............................................................................. 14

SUBSCRIPTION OPTIONS ......................................................................................... 15
Individuals ....................................................................................................................... 15
Teachers, schools, districts, and consortia ..................................................................... 15

CHAPTER 2: GETTING STARTED .............................................................................. 16

LOGGING IN .................................................................................................................... 16
Individual subscribers ..................................................................................................... 16
Group subscribers (classrooms, schools, districts, etc.) ................................................ 17

PERSONAL FOLDERS .................................................................................................. 17
Overview .......................................................................................................................... 17
Creating a new personal folder ....................................................................................... 18
Individual subscribers .................................................................................................... 18
Group subscribers (classrooms, schools, districts, etc.) ................................................ 18
Revalidating a personal folder ....................................................................................... 20
CHAPTER 3: CITING SOURCES ................................................................. 31

THE PROCESS ................................................................................. 31
Adding citations .............................................................................. 31
Editing citations .............................................................................. 32
Deleting citations ............................................................................ 32
Undeleting citations ....................................................................... 33
Copying citations ............................................................................ 33
SELECTING A CITATION TYPE ........................................................ 34
Available citation types .................................................................. 34
Selecting the correct citation type for your source ......................... 34
FORM BASICS .................................................................................. 36
Required fields ................................................................................ 39
Name fields ..................................................................................... 39
CHECKING FOR COMMON ERRORS ................................................... 40
PARENTHEtical REFERENCE HELP (MLA AND APA only) ..................... 41
LABELING PRIMARY, SECONDARY AND TERTIARY SOURCES ............... 42
Applying descriptions to citations ................................................... 42
Removing descriptions from citations .............................................. 44
SORTING SOURCE LISTS IN ALTERNATIVE WAYS ................................. 44
PRINTING CITATIONS ...................................................................... 45
Formatting ....................................................................................... 45
Changing the title ............................................................................ 45
Adding a header (MLA and APA only) .............................................. 46
Underlining vs. italics (MLA only) ................................................... 46
Annotation spacing (MLA only) ...................................................... 47
Including or omitting annotations .................................................. 47
Other formatting ............................................................................. 47
Adding your source list to your research paper .................................. 47
Opening the RTF file in the right word processor ............................... 49
A note about WordPerfect and hanging indents ................................. 49
Printing ......................................................................................... 50

Modifying your profile and personal folder password ........................ 22
Individual subscribers ...................................................................... 22
Group subscribers (classrooms, schools, libraries) ............................ 22

CREATING A PROJECT ...................................................................... 22
The personal folder view ................................................................. 22
Creating a new project ..................................................................... 23
My Projects .................................................................................... 24
THE DASHBOARD ........................................................................... 26
Overview ....................................................................................... 26
Working with the Dashboard ............................................................ 27
Student's view ................................................................................ 27
Teacher's view .............................................................................. 30

CHAPTER 4: NOTECARDS AND OUTLINE ............................................. 51
WHAT ARE NOTECARDS? .................................................................. 51
OVERVIEW .................................................................................. 51
Access to the notecards feature .................................................. 51
Notecards .................................................................................... 52
Approaches to note-taking .......................................................... 53
WORKING WITH NOTECARDS ......................................................... 54
Note-taking skills enabled by this software .................................. 54
The Notecard Tabletop ................................................................. 56
Navigating the tabletop ............................................................... 56
Creating and manipulating notecards .......................................... 57
Creating a notecard .................................................................... 57
Editing a notecard ...................................................................... 60
Linking notecards to sources ..................................................... 60
Viewing notecard details ............................................................ 61
Deleting a notecard .................................................................... 62
Undeleting a notecard ............................................................... 62
Renaming a notecard ............................................................... 63
Creating and manipulating notecard piles ................................... 63
What is a notecard pile? ............................................................ 63
Creating a notecard pile ............................................................ 63
Viewing and modifying a notecard pile ...................................... 64
Deleting a notecard pile ............................................................ 65
Renaming a notecard pile .......................................................... 65
Reordering notecards within a notecard pile .............................. 65
Notecard tags .............................................................................. 65
What is a tag? ............................................................................ 65
Why are tags useful on notecards? ............................................. 66
Associating tags to notecards .................................................... 67
Renaming and deleting tags ...................................................... 68
Notecard colors and visual cues ................................................... 68
Colors ..................................................................................... 68
Visual cues ............................................................................. 70
Searching notecards .................................................................. 70
Printing notecards .................................................................... 72
THE OUTLINE ............................................................................. 72
Creating an outline ................................................................... 72
Why use an outline? ............................................................... 73
Creating items in the outline .................................................... 74
Moving items in the outline ..................................................... 75
Deleting outline items ............................................................ 76
Adding notecards to your outline ............................................. 76
Printing the outline .................................................................. 77
CHAPTER 5: THE PAPER ............................................................... 78
Google Docs Overview .............................................................. 78
CREATING A PAPER .................................................................................................................. 78
SHARING THE PAPER WITH A TEACHER .............................................................................. 79
COLLABORATING ON A PAPER ............................................................................................ 80
GOOGLE APPS FOR EDUCATION .......................................................................................... 80

CHAPTER 6: WORKING WITH PROJECTS .............................................................................. 82
COPYING PROJECTS .............................................................................................................. 82
SHARING PROJECTS .............................................................................................................. 83
Teacher instructions .............................................................................................................. 83
Archiving old assignment drop boxes .................................................................................. 88
Student instructions ................................................................................................................ 89
STUDENT COLLABORATION .................................................................................................. 91
Adding Collaborators ............................................................................................................ 91
Working on a collaborative project ....................................................................................... 93
Teacher’s view of a collaborative project .............................................................................. 94
Deleting a collaborative project ............................................................................................. 95
E-MAILING PROJECTS ........................................................................................................... 95
MERGING PROJECTS ............................................................................................................. 96
DELETING PROJECTS ............................................................................................................. 97
ARCHIVING PROJECTS .......................................................................................................... 97
RENAMEING PROJECTS .......................................................................................................... 98

CHAPTER 7: TROUBLESHOOTING ......................................................................................... 99
OVERVIEW ............................................................................................................................... 99
COMMON QUESTIONS ........................................................................................................... 100
Subscribing ............................................................................................................................. 100
“How much does subscribing cost?” .................................................................................... 100
“I submitted a subscription request for my school but it has been over 24 hours and I haven’t
received any response.” ......................................................................................................... 100
Using NoodleBib ..................................................................................................................... 101
“How do I enable cookies and JavaScript in my browser?” ................................................ 101
“Why am I getting a Page cannot be displayed or Page expired error?” ............................... 102
“When I click on the help links next to the citation fields in NoodleBib, nothing happens.” ... 103
## Table of Figures

<table>
<thead>
<tr>
<th>Figure</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Login screen</td>
<td>16</td>
</tr>
<tr>
<td>2</td>
<td>Creating a personal folder</td>
<td>19</td>
</tr>
<tr>
<td>3</td>
<td>Revalidating a personal folder</td>
<td>21</td>
</tr>
<tr>
<td>4</td>
<td>Empty folder (teacher's view includes Projects Shared with Me)</td>
<td>23</td>
</tr>
<tr>
<td>5</td>
<td>Personal folder (My Projects view)</td>
<td>24</td>
</tr>
<tr>
<td>6</td>
<td>Dashboard</td>
<td>26</td>
</tr>
<tr>
<td>7</td>
<td>Adding a to-do item</td>
<td>29</td>
</tr>
<tr>
<td>8</td>
<td>Choosing a citation type</td>
<td>31</td>
</tr>
<tr>
<td>9</td>
<td>&quot;Magazine&quot; selected as the citation type (MLA Advanced)</td>
<td>35</td>
</tr>
<tr>
<td>10</td>
<td>&quot;Online Database&quot; selected as the citation type (MLA Advanced)</td>
<td>36</td>
</tr>
<tr>
<td>11</td>
<td>MLA Starter citation form (newspaper article in a database)</td>
<td>37</td>
</tr>
<tr>
<td>12</td>
<td>MLA Advanced citation form (partial form shown)</td>
<td>38</td>
</tr>
<tr>
<td>13</td>
<td>Field for adding names of authors and other contributors</td>
<td>39</td>
</tr>
<tr>
<td>14</td>
<td>Example of “Check for Errors” results</td>
<td>41</td>
</tr>
<tr>
<td>15</td>
<td>Parenthetical Reference (i.e., in-text reference) help link</td>
<td>41</td>
</tr>
<tr>
<td>16</td>
<td>Parenthetical reference help</td>
<td>42</td>
</tr>
<tr>
<td>17</td>
<td>Dropdown menu for classifying sources</td>
<td>42</td>
</tr>
<tr>
<td>18</td>
<td>“Secondary sources” label applied to a citation</td>
<td>43</td>
</tr>
<tr>
<td>19</td>
<td>Sorting a source list by media type</td>
<td>45</td>
</tr>
<tr>
<td>20</td>
<td>Notecards screen</td>
<td>56</td>
</tr>
<tr>
<td>21</td>
<td>Creating a new notecard (Bibliography screen)</td>
<td>57</td>
</tr>
<tr>
<td>22</td>
<td>Creating a new notecard (Notecards screen)</td>
<td>57</td>
</tr>
<tr>
<td>23</td>
<td>New notecard form</td>
<td>58</td>
</tr>
<tr>
<td>24</td>
<td>New Notecards region</td>
<td>59</td>
</tr>
<tr>
<td>25</td>
<td>Notecard summary pop-up</td>
<td>60</td>
</tr>
<tr>
<td>26</td>
<td>Notecard display options</td>
<td>61</td>
</tr>
<tr>
<td>27</td>
<td>Undelete notecards</td>
<td>62</td>
</tr>
<tr>
<td>28</td>
<td>Notecard pile</td>
<td>63</td>
</tr>
<tr>
<td>29</td>
<td>Expanded notecard pile</td>
<td>64</td>
</tr>
<tr>
<td>30</td>
<td>Adding word/phrase tags</td>
<td>68</td>
</tr>
<tr>
<td>31</td>
<td>Notecard colors</td>
<td>69</td>
</tr>
<tr>
<td>32</td>
<td>Notecard visual cues</td>
<td>70</td>
</tr>
<tr>
<td>33</td>
<td>Visual cues on notecards</td>
<td>70</td>
</tr>
<tr>
<td>34</td>
<td>Find notecards by keyword(s)</td>
<td>71</td>
</tr>
<tr>
<td>35</td>
<td>Selected notecard count</td>
<td>71</td>
</tr>
<tr>
<td>36</td>
<td>Blank outline</td>
<td>74</td>
</tr>
<tr>
<td>37</td>
<td>Outline</td>
<td>75</td>
</tr>
<tr>
<td>38</td>
<td>Moving notecards into the outline</td>
<td>76</td>
</tr>
<tr>
<td>39</td>
<td>Sharing the Google Docs paper</td>
<td>79</td>
</tr>
<tr>
<td>40</td>
<td>Copying a project</td>
<td>82</td>
</tr>
<tr>
<td>41</td>
<td>Projects Shared with Me (teacher's view of shared projects)</td>
<td>84</td>
</tr>
<tr>
<td>42</td>
<td>Teacher’s view of a shared project</td>
<td>87</td>
</tr>
<tr>
<td>43</td>
<td>Archived assignment drop boxes</td>
<td>89</td>
</tr>
<tr>
<td>44</td>
<td>Shared projects (one with new comments)</td>
<td>90</td>
</tr>
<tr>
<td>45</td>
<td>Teacher’s comment displayed below a student's citation</td>
<td>90</td>
</tr>
</tbody>
</table>
Welcome to NoodleBib, a platform for student research which is anchored in the best practices of academic research and inquiry learning. Known as the most comprehensive and accurate bibliography composer on the Web, NoodleBib also includes note-taking and outlining components that enable a researcher, alone or with others, to extract, organize and synthesize information. Members of a group can work in real-time on an interactive tabletop to take notes, cite and annotate sources, then outline and write a paper. Multiple instructors can monitor an individual's contributions to the project and give in-context feedback that is visible on students' dashboards. Our seamless integration with Google Docs gives students a robust online composing space and permits instructors to do paperless evaluation and provide feedback directly on students' work. NoodleBib is a flexible teaching tool which supports both individual learning preferences and a variety of teaching styles.

Taking notes and correctly citing your sources have never been easy, as the 50-70% of students who admit to plagiarism can testify. To extract, understand, summarize, synthesize and integrate notes from multiple online and print sources requires both analytical and creative thinking. Documenting those sources by sifting through hundreds of pages of the appropriate style manual is challenging – and the examples don’t always match the information you have for the source you want to cite. Finally, printed notes aren’t as easy to compare in order to evaluate the authority and value of your sources.

That’s not to say that notecard models and citation examples aren’t available. Many Web sites show examples of summaries and paraphrasing on note-taking cards or offer digital note programs. However directing someone to “say it in your own words” doesn’t provide the just-in-time scaffolding and organizational structure necessary to produce your own work thoughtfully and creatively. Similarly thousands of Web sites and databases contain sample citations and a good number of citation generators offer to automate the process. If you compare a citation given on one site with one on a different site, you are likely to become confused – they’re inconsistent. University professors, database vendors, and librarians often disagree about methods and formats.

The NoodleBib solution: Convenient Web-based software to extract and organize notes from your sources as you build an outline and working bibliography. Tools that help you think, assess, and synthesize ideas -- and complete a polished essay and source list that accurately reflects the latest
editions and interpretations of the *MLA Handbook*, *APA Publication Manual*, or Turabian’s *Manual for Writers* (or *Chicago Manual of Style*).

**About this guide**

This reference manual provides step-by-step instructions with screenshots that show how to use the program. The topics are ordered in the way you will likely encounter them as you use the program.

**Additional help**

If you are unable to find the information you are looking for in this guide, there are several other ways to obtain help.

**NoodleBib overview tour**

If this is your first time using NoodleBib, or you want a high-level overview of the software, this short tour with screenshots is a good place to start:

http://www.noodletools.com/tour/

**NoodleBib screencasts**

Short movie tutorials are often the best way to learn about features of the software that you aren’t familiar with.


**NoodleBib PowerPoints**

PowerPoint presentations can be customized and used by librarians and faculty to provide an overview of NoodleBib to students and other faculty.


**NoodleTools Knowledge Base**

The NoodleTools Knowledge Base is a searchable database of how-to articles and expert answers to some of the trickiest citation questions using examples of sources and databases you are likely to encounter. If you are having trouble figuring out how to cite a source correctly, you’ll want to search the NoodleTools Knowledge Base.

**NoodleTools Support**

Submit a “ticket” through the “Contact Us / Submit Ticket” link if you have a presales question or you need information about an existing subscription. The form routes your question to the expert who can help you best. We respond to all questions via e-mail within 24 hours.

http://www.noodletools.com/helpdesk/

**NoodleBib “Have a Question?” links**

A “Have a Question?” link appears next to every citation that you create in NoodleBib. If you aren’t sure whether you composed the citation correctly, click the link to submit your question to us. Our team will personally assist you with the citation via e-mail. All questions are answered within 24 hours.

**NoodleTools.info**

If you are unable to access the Web site and you believe the issue may be on our side, check the NoodleTools Server Status site NoodleTools.info to determine if (and why) the server is offline.

http://www.noodletools.info/

Note that all scheduled maintenance will be preannounced on the NoodleTools blog, Noodling. We urge you to subscribe (by RSS feed or e-mail) to the blog so that you are notified in advance and can plan accordingly.

http://www.noodletools.com/blog/

**Contacting NoodleTools**

For questions that cannot be answered via online communications, you may call us at (650) 561-4071. Subscription purchase orders and other correspondence should be faxed to (650) 618-1911.

Our mailing address is:

NoodleTools, Inc.
P.O. Box 60214
Palo Alto, CA 94306-0214
Chapter 1: Requirements and Options

System requirements

NoodleBib is a Web-based tool, which means that teachers, students and professionals can access and edit their work from any computer with Internet access. There is no software to install on your own computer or your school’s server – only a Web browser is required to access the NoodleTools Web site.

Browser requirements

Minimum requirements

Although NoodleBib has been designed to work with any available graphical Web browser, we recommend that you use a configuration listed below. These are the ones that we use for testing the software internally. While NoodleBib will work with other browsers and browser versions, we do not support those alternative configurations.

- Microsoft Internet Explorer: Versions 7.x and higher (PC only)
- Mozilla Firefox: Version 3.x and higher (PC and Mac)
- Safari: Version 3.x and higher (PC and Mac)
- Google Chrome 2.x and higher (PC only)

The notecards feature, in particular, depends on cutting-edge DHTML and AJAX technologies that are only supported well in the browsers noted above.

Browser settings

You must have both cookies and JavaScript (also called active scripting) enabled in your browser. If one of these features is disabled, you will not be able use NoodleBib. For instructions on how to enable JavaScript and cookies in your particular browser, refer to “How do I enable cookies and JavaScript in my browser?” in Troubleshooting in Chapter 7.

NoodleBib versions

NoodleBib MLA Starter (free)

NoodleBib MLA Starter can be accessed via the NoodleBib MLA Starter link on the NoodleTools home page (under Free Software Tools), or directly via the URL:

http://www.noodletools.com/noodlebib/starter.php
NoodleBib MLA Starter is free and designed for novices including students in the elementary grades and second language learners with limited English who are just learning to create a bibliography. It introduces citation basics by providing clear, color-coded examples of how to cite the sources they are most likely to encounter (e.g., books, reference sources, journals, magazines, newspapers, Web pages, e-mails, interviews, films, oral presentations, TV/radio, and artwork/photographs).

Even emergent readers can enter elements for one citation, then copy and paste the resulting citation into a word-processed document. As students learn to use the NoodleBib software, they can create a folder with several citations and one or more projects, and then export a correctly formatted bibliography into a word-processed document.

Once students are familiar with the software interface and citation concepts introduced in NoodleBib MLA Starter, their transition to the advanced versions will be easier. With a common process and consistent language, educators can create a culture of attribution throughout the school.

**NoodleBib Express (free)**

NoodleBib Express can be accessed via the NoodleBib Express link on the NoodleTools home page (under the heading Free Software Tools) or directly via the URL:

http://www.noodletools.com/noodlebib/express.php

NoodleBib Express, also free, is designed for students who just need one or two quick citations. While citations cannot be compiled and saved as a source list, the entire range of citation types from the advanced tools (MLA, APA, and Chicago/Turabian) is available in Express.

**NoodleBib (Subscription Version)**

The subscription version of NoodleBib (with comprehensive coverage of MLA, APA, and Chicago/Turabian styles) can be accessed via the Current Users: Sign In link on the NoodleTools home page (under the heading NoodleBib).

If you are accessing NoodleBib through a school’s or library’s subscription, you may be instructed to use a customized login link for that school or library.
Integration with Pearson’s MyCompLab

NoodleBib is seamlessly integrated into Pearson’s MyCompLab, a writing instruction environment. From the MyCompLab composing space, a student can click the “Cite sources” link in the Writer’s Toolkit to open NoodleBib, create a source list and notecards, and then import that work directly back into the MyCompLab editor.

For more information:
http://www.mycomplab.com/
## Version comparison chart

<table>
<thead>
<tr>
<th>Feature</th>
<th>NoodleBib MLA Starter</th>
<th>NoodleBib Express</th>
<th>Individual Subscription</th>
<th>MyCompLab integration</th>
<th>School/Dist. or Teacher Subscription</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Cost</strong></td>
<td>Free</td>
<td>Free</td>
<td>$4 - $8</td>
<td>Free with MyCompLab</td>
<td>See online pricing</td>
</tr>
<tr>
<td>No login required</td>
<td>●</td>
<td></td>
<td></td>
<td>(single sign-on)</td>
<td></td>
</tr>
<tr>
<td>MLA Starter</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>MLA Adv., APA, Chicago</td>
<td></td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Parenthetical reference help (and footnotes for Chicago style)</td>
<td>●</td>
<td></td>
<td></td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Create an entire bibliography</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Save work in a personal folder</td>
<td>●</td>
<td></td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Export as RTF (Word doc)</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Integrated with Google Docs</td>
<td>●</td>
<td>●</td>
<td></td>
<td>(uses MCL composing space)</td>
<td>●</td>
</tr>
<tr>
<td>Create notecards</td>
<td></td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Create an outline</td>
<td></td>
<td></td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Expert citation help from NoodleTools staff</td>
<td></td>
<td></td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Share work with teacher</td>
<td></td>
<td></td>
<td></td>
<td>●</td>
<td></td>
</tr>
<tr>
<td>Student collaboration</td>
<td></td>
<td></td>
<td>●</td>
<td>●</td>
<td></td>
</tr>
<tr>
<td>Admin area (manage users, usage stats, etc.)</td>
<td></td>
<td></td>
<td></td>
<td>●</td>
<td></td>
</tr>
<tr>
<td>Local time zone support</td>
<td>●</td>
<td></td>
<td></td>
<td>●</td>
<td></td>
</tr>
</tbody>
</table>
**Subscription options**

**Individuals**
The registration form for individual users can be found at:

http://www.noodletools.com/subscriber/signup.php

You are eligible for the individual subscription rates if you and your family members will be the only ones using the account. NoodleTools subscriptions for individual/family accounts must be purchased using one of our online credit card payment services.

**Individual subscription rates:** $4.00 for 3 months, $6.00 for 6 months (25% discount), or $8.00 for 12 months (50% discount).

**Teachers, schools, districts, and consortia**
**Subscription information** and pricing for group can be found at:

http://www.noodletools.com/tools/subscriptions.php

To request a trial to evaluate the product, complete the online trial request form:

http://www.noodletools.com/tools/trial.php

To begin a subscription, complete the online subscription request form:

http://www.noodletools.com/tools/subscribe.php

**Note:** We do not currently offer subscriptions to public libraries.
Chapter 2: Getting Started

Logging in

Figure 1: Login screen

Individual subscribers

Logging in to an individual account

→ Point your browser to http://www.noodletools.com/login.php or click the Current Users: Sign In button on the NoodleTools home page.

→ Enter the personal ID and password you selected on the registration form when you signed up for the service. **Important:** Your personal ID is not case-sensitive. Your password is case-sensitive.
  
  o If you are a new user, refer to the Creating a new personal folder in this chapter.

→ If you cannot remember your personal ID and/or your password, click the I forgot my password link beneath the Password field, select the An individual subscription I purchased via PayPal or PayFlow Link option on the next screen, and then enter either your personal ID or your e-mail.
address on the next screen. Your personal ID and password will be e-mailed to you.

→ Clicking the checkbox titled Remember me will direct NoodleBib to save your login data, so that the next time you visit NoodleBib your personal ID and password will be automatically filled in for you.

→ If your login is successful, you will see your personal folder (with “My Projects” at the top).

**Group subscribers (classrooms, schools, districts, etc.)**

Logging in to a group account

→ Click the link to NoodleBib on your school’s or library’s Web page. If there isn’t one, click the Current Users: Sign In link on the NoodleTools home page.

→ Enter the personal ID and password that you selected the first time you logged in to this school/library subscription. Your personal ID and password are different than your school’s remote access username/password. Your personal ID and password are not case sensitive.
   ○ If you are a new user, click “Create a Personal ID” (refer to the Creating a new personal folder section in this chapter).

→ If you cannot remember your personal ID and/or your password, click the I forgot my password link, select the A subscription I have access to through my library, school or district option on the next screen, and then enter your personal ID and last four digits of your phone number on the next screen. A password hint will be displayed on the screen. If you still aren’t sure of your password after viewing the password hint, the NoodleTools administrator at your school or library can log in to the subscription management area to find or reset your login information.

→ Clicking the checkbox titled Remember me will direct NoodleBib to save your login data, so that the next time you visit NoodleBib your personal ID and password will be automatically filled in for you. Do not use this feature when you are accessing the site from a public location (school, library, etc.).

→ If your login is successful, you will see your personal folder (with “My Projects” at the top).

**Personal folders**

**Overview**

The My Projects screen of your personal folder provides you with a unified view of all the projects that you have access to in NoodleBib. Important information
like the project description, style (MLA, APA, or Chicago/Turabian) and level (Starter or Advanced) is indicated alongside each project to help you identify and track your work. The My Projects screen also allows you to easily perform certain tasks that involve two or more projects together. For example, you can merge several projects into a single combined project.

The screen serves an additional function for classroom teachers – a Projects Shared with Me area of the teacher’s personal folder gives an instructor the opportunity to monitor students’ progress and provide helpful feedback to individual students directly within NoodleBib (see Sharing projects in Chapter 6).

Creating a new personal folder

Individual subscribers
Individuals can subscribe to the full version of NoodleBib as described in Subscription options in Chapter 1.

If you are an individual subscriber, a personal folder is created automatically for you the first time you log in. After entering the personal ID and password you selected on the sign-up form, you will see your personal folder view (with My Projects selected).

You can modify your personal ID and password by clicking the My Account link near the top of the screen (see Modifying your profile and personal folder password in Chapter 2).

Group subscribers (classrooms, schools, districts, etc.)
If you are logging in to a subscription created for your classroom, school, university, library, company, or other organization for the first time, you will need to create a personal folder. Your personal folder is essentially an account just for you, created within the larger group account.
Creating your personal folder
- On the login screen, click **Create a Personal ID**.
- If your school or library has set up **automatic authentication**, you will be taken directly to the **New User Registration** screen.

If you are not automatically authenticated:
- If asked what type of folder you wish to create, choose the option to create an **account linked to a school/library subscription or trial**.
- Enter the school/library username and password or library barcode when prompted for them. Ask your teacher or librarian for help if you don’t know how to log in.

**Figure 2: Creating a personal folder**

![New User Registration](image)

**About You**
- I am a student or library patron
- I am a teacher or librarian
- Expected year of graduation: 2012

**Choose a Personal ID**
You'll use this personal ID and password to access your saved work.
- Personal ID: Example TourGuide
- Password: ********
- Retype password: ********

**Easy Login Retrieval**
Just in case you lose your personal ID or password, provide your first/last initials and the last 4 digits of your phone number so that we can identify your account and help you out.
- Initials: ET (e.g. "JS" for John Smith)
- Phone: 2525 (last 4 digits only)

Register
→ On the **New User Registration** screen, don’t change the default selection under **About you** if you are a student or library patron. If you are a teacher or librarian, change the selection so that your students will be able to share their work with you.

→ If you are a student, select the year you expect to graduate from the school that you currently attend. Depending on the subscription type, there may be an additional dropdown list from which you will select the name of your school (not pictured here).

→ Under **Choose a Personal ID**, select a personal ID and a password that you will remember. You will need to enter this login information to access your personal folder every time you open NoodleBib. The password is **not** case-sensitive and must be 4 or more characters long. Do not share this password with your classmates.

→ To save time, click the **Check availability** button to see whether or not the personal ID you have selected is available. If you have selected a personal ID that is already in use, you can change it now before clicking the **Register** button.

→ Finally, under **Easy Login Retrieval**, enter the last four digits of your phone number and your initials. This is used to identify you if you lose your password or if we need it to locate your account.

→ Click the **Register** button.

### Revalidating a personal folder

You are required to **revalidate** your personal folder the first time you log in after **August 1st** each year if your personal folder is under a group subscription (teacher/school/district license). If your school/district has some form of automatic authentication enabled (proxy server, IP authentication, referring URL authentication), this revalidation process may be transparent to you. For example, if IP authentication is enabled and you are on campus the first time you log in after 8/1, your folder will be revalidated automatically.
If automatic authentication is not active, you will see a screen after you enter your Personal ID and password that says that you must revalidate your personal folder.

**Figure 3: Revalidating a personal folder**

The screen allows you to skip the revalidation step for up to 3 weeks. During that three-week period, you can click the “Skip Revalidation For Now” button and proceed into your folder. After that date, this screen will no longer allow you to skip the revalidation — you will need to enter the current subscription username/password for your school or district in order to continue. Nothing is lost or deleted — you are simply not permitted to log in until you revalidate the folder. Note that if your school’s automatic authentication occurs at any time during or after this period, the revalidation process will be complete and this screen will no longer be displayed.

The purpose of “revalidation” is to prevent (or discourage) students who have graduated from a school to log back in to their old folders. Only current students should be using a school’s or district’s subscription. NoodleTools does offer an inexpensive option for individual students who would like to save their work and continue to use a subscription at their next school.
Modifying your profile and personal folder password

Individual subscribers
To change your profile
→ Log in using your personal ID and password.
→ With My Projects selected, click the My Account link near the top of the screen.
→ Click the link under Your Profile: “Click here to change your username, password, name, or e-mail address.”
→ Make the necessary changes and click Save to save your changes.

Group subscribers (classrooms, schools, libraries)
To change your profile
→ Log in using your personal ID and password.
→ With My Projects selected, click the My Account link near the top of the screen.
→ Update your personal information and then click Save Profile to save your changes.
→ Note: You will also be prompted to update your profile the first time you log in after August 1st each year. If you have changed schools, be sure to select your current school from the Location dropdown list.

Creating a project

The personal folder view
The first time you open your personal folder, it will be empty. If you are a student, a single empty table titled My Projects is displayed, along with a large button titled Create a New Project.

If you are a teacher or librarian, you’ll find a second table below My Projects titled Projects Shared with Me. Projects that students share with you will eventually appear in this area, organized by assignment (see Chapter 6: Sharing projects).
Creating a new project

To create a new project, click the Create a New Project button in your personal folder (with My Projects selected). On the Create a New Project screen, you must provide some information before NoodleBib allows you to begin a project:

→ **Step #1: Choose the source list style and version.**
   Ask your teacher or instructor before choosing between MLA, APA, and Chicago/Turabian.

You will **not be able to switch between formats later**, except to convert an MLA Starter source list to MLA Advanced (but not vice versa).

MLA Starter is a simplified tool for younger students and has a limited set of citation types available: Book, journal, magazine, newspaper, reference source, e-mail, Web site, artwork/photograph, film or video recording, lecture, speech, address or reading, television or radio program, and personal interview.

→ **Step #2: Provide a brief description**
   Enter a brief description that will help you remember the contents or purpose of this project when you see it later among other projects in your personal folder.
At the bottom of the page, click **Create Project** to begin a new project. If you change your mind, click **Cancel** to return to your personal folder.

### My Projects

When you create a project in NoodleBib, it will appear in the **My Projects** table. The project that was most recently revised will appear at the top. To open a project, click the hyperlink under the **Description** heading. The project that you are currently editing will be displayed in your personal folder with a yellow background and the word “open” in parentheses beside the project description.

![Figure 5: Personal folder (My Projects view)](image)

Column headings and their meanings

- **Description**: A short description that you create when you start a new project. It helps you remember the contents of each project in your personal folder. Keep in mind that your teacher or instructor will see your written description if you share this project with him or her.
- **Style**: MLA, APA, or CHI (Chicago/Turabian)
- **Level**: Starter or Advanced
- **Entries**: The number of citations in the source list
- **Notes**: The number of notecards associated with the project (only visible if the notecards feature is enabled).
- **Created**: The date and time you first created the project
- **Modified**: The date and time you last edited the project
→ **Shared?**: Indicates if you have shared the project with someone, and whether or not that person has submitted new feedback to you. Indicators are:
  → Blank = the project has not been shared with anyone.
  → ✔️ = the project has been shared but no new feedback has been submitted back to you.
  → 🔄 = the project has been shared and there is new feedback on citations and/or notecards that you can view by opening the project.
  Mouse-over the ✔️ or 🔄 indicator to view a list of the drop boxes that the project is currently shared with.
→ **Collaborating?**: Indicates if other students are collaborating on this project with you. Indicators are:
  → Blank = no other students current have access to the project
  → ✔️ = one or more students are collaborating on the project with you.
  Mouse-over the ✔️ indicator to view a list of the students who are collaborating on the project with you.
The Dashboard

Overview

When you click on a project’s description to open it from the My Projects screen, the Dashboard opens.

Figure 6: Dashboard
The Dashboard provides:

- A place for you to write a research question and thesis statement.
- Created and modified dates for the project.
- Information about the assignment drop boxes and teachers that the project is shared with (and a link to share it with additional drop boxes).
- Information about the students you are collaborating with on the project (and a link to add or remove collaborators).
- Teacher-selected relevant links (which could be a calendar, an assignment sheet, a pathfinder, blog, wiki, etc.). These links will appear for the student if (a) the student has shared the project and (b) the teacher has associated links to the drop box (via the Sharing Setup screen).
- Navigation links and status information about the project components (bibliography, notecards, outline and the paper). The number of citations and notecards are displayed.
- A student-created to-do list to keep track of tasks, assignments and milestones.
- Unified display of the teacher or librarian’s general observations, as well as specific comments linked back to the specific bibliography entry or notecard.

**Working with the Dashboard**

**Student’s view**

Depending on the complexity and requirements of the assignment, you may or may not use all of the Dashboard components.

**Research question and thesis statement**: After you have done some initial investigation and focused your research topic, express the topic in the form of a research question.

Example: “How should we manage e-waste?”

Then formulate a thesis statement that answers the question. This sentence states your main idea precisely and succinctly. Your thesis will guide your extraction of evidence and ideas for your notes, the structure of your outline, and your final presentation.

Example: “We need a multinational solution to e-waste management because developed countries won’t regulate their booming electronics industries and..."
third-world countries won’t regulate lucrative metals extraction industries in spite of health and environmental problems for their people.”

On the Dashboard screen, click the “[Click to Edit]” text to edit these fields (the text editor will open in place – click outside of the edit field to save what you have written).

**Sharing:** Your project may be shared with one or more assignment drop boxes, as described in *Sharing projects* in Chapter 6. Information about these drop boxes appear in the Sharing area of the Dashboard.

If no checkmark is visible in the “Paper” column, then either the student did not create a Google Docs paper for the project yet, or he chose to exclude the paper when he shared the project.

**Links:** If teachers add resource links to an assignment drop box, those links will show up in the Links area. For example, if the project is shared with two drop boxes, A and B, and there is a Google calendar link associated with drop box A and an assignment sheet link associated with drop box B, both the calendar and assignment sheet links will show up here.

**Student Collaboration:** If you are working together with classmates on a project, information about which students have access to which components of the project appear in the Student Collaboration area of the Dashboard.

If no checkmark is visible in the “Paper” column, then no students have created a Google Docs paper for the project yet.

If the words “(No Google ID)” appear for a student (under “Paper”), it means that the student did not have a Google Account ID defined in his profile when the project was shared with him. If the student needs access to the Google Doc associated with the project, he should click the “My Account” link near the top of the screen to edit his profile and add his Google Account ID. Then one of his team members who does have access to the paper can click the “Share Google Docs paper with these students” link in the Student Collaboration area to give the other student access to that paper.

**Components:** The components area provides navigation links to the bibliography, notecards/outline, and Google Docs paper. In addition, the number of citations and notecards created are displayed.
To-do list: Add to-do list items by clicking the green Add to-do item (.addButton) button. Then fill in the description of the to-do item and select a due date for the item by clicking on the calendar button and choosing the date from the calendar popup.

Figure 7: Adding a to-do item

When a to-do item on the list is completed, mark the box next to the item. A green checkmark will fill the checkbox, and the completion date will be auto-filled for you. You may also uncheck a to-do list item if you have made a mistake or have further work to do.

To edit an existing to-do item, click the pencil (editIcon) icon on the right side of the item. To delete the item, click the red delete (deleteIcon) icon.

Comments: Any citation, notecard, or general comments added by teachers to the project will display in the Comments area, with the most recent comment at the top. If a comment is specific to a citation or notecard, a “view comment in context” link at the end of the comment will be displayed. Clicking this link will open the Bibliography screen and scroll the page down to place the comment in view. New comments are displayed with a New icon. Comments are not considered “read” when you view them on the Dashboard – only when the comments are viewed on the Bibliography or Notecards screens.
If you have made the changes suggested in the comment and wish to delete it, click the red delete (●) icon next to the comment. Note: This only deletes the comment in your view – the teacher that wrote the comment will still see it on her view of the Bibliography screen, along with a note that you have deleted it.

Teacher’s view

Teachers and librarians will find that the teacher’s view of the student’s Dashboard is an efficient way to monitor progress and offer feedback.

The teacher’s view of the Dashboard is mainly read-only while the student’s Dashboard is a working environment. The research question, thesis statement, and to-do list can only be changed by the student. However, a teacher can add a “general” comment (a comment that is not specific to a certain citation or notecard) to the Comments area by clicking the green Add comment (●) button.
Chapter 3: Citing Sources

The process

Adding citations

In the navigation bar at the top of the screen, click Bibliography to begin adding citations to a new project’s source list. On the screen you will see a dropdown list with the label “Cite a:” that contains all of the citation types available.

Figure 8: Choosing a citation type
Citing Sources

Creating a citation
→ Click the Create Citation button after you have made your selection from the dropdown list.
→ A series of screens will prompt you for information about your source (the screens you see will vary depending on the citation type). NoodleBib uses your answers to tailor the final form, so that only the fields and instructions that are exactly right for your particular source are shown.
→ When you arrive at the main form, fill in as many details about your source as you can locate, reading the help screens for tips on format.
→ An Annotation field at the bottom of every citation form allows you to create an annotated bibliography. Use the spell-check link above the annotation field to assist with spelling.
→ Click Check for Errors to scan your entry for common mistakes (see the Check for Errors section later in this chapter). After making corrections, submit the form to create your citation.
→ If there are several citations in your source list, a link at the top of your bibliography (“Jump to citation I just edited”) takes you to the citation you just added.
→ Repeat all steps above for each source you wish to cite.

Editing citations

Editing a citation
→ Find the entry you wish to edit and click the Edit button (Edit).
→ Modify the information about your source.
  Note: If you realize you have chosen the wrong citation form (for example, you chose print instead of online), you will need to delete the entry and begin again. You can copy and paste the incorrect citation into a word processor and then copy elements from there into the new citation instead of starting from scratch.
→ Click Update Citation.
→ If there are several citations in your source list, a link at the top of your bibliography (“Jump to citation I just edited”) takes you to the last citation you edited.

Deleting citations

Deleting one citation from your source list
→ Find the entry you wish to remove and click the red Delete button (Delete).
→ Click OK when asked “Are you sure you want to delete this entry?”
Deleting multiple citations at once
→ Mark the checkboxes next to the citations you wish to delete, along the left side of the source list.
→ Scroll down to the bottom of the screen and click the Delete button (with the label “Select one or more items and perform an action”).
→ Click OK when asked “Are you sure you wish to delete all of the entries that are selected above?”

Undeleting citations
Recovering citations that you deleted from a source list
→ Click the Recycle Bin button ( ) at the top of the Bibliography screen.
→ A Restore Deleted Citations window will appear that allows you to select the citations that you wish to undelete. Mark the checkboxes next to the citations you wish to recover, along the left side of the window.
→ Click the Undelete button.

Note: Notecards become unlinked from a citation when the citation is deleted (they become “thought cards”). If you undelete the citation later on, you will need to relink the notecards to that citation. See Linking notecards to sources in Chapter 4 for information on how to do that quickly.

Copying citations
Copying a citation
→ With Bibliography selected in the navigation bar, find the entry you wish to copy and click the Copy button ( ).
→ From the Copy Citations screen, a copy of the citation may be made in the project you have open, or the citation can be copied to another project in your folder. Note that if you choose to copy the citation to a different folder, it can only be copied to a folder of like style (MLA, APA, or Chicago/Turabian). Citations created in the MLA Advanced tool cannot be copied to an MLA Starter project, although a copy can be made in the opposite direction.
→ Click Copy. If you are creating a copy of the citation in the project you have open, you will be taken to a form where the new (copied) citation can be edited. If the citation is copied to a different project, you will be given an option to either open the project that you copied the citation to or remain in the project you already have open.
Copying multiple citations at once

→ With Bibliography selected in the navigation bar, mark the checkboxes next to the citations you wish to copy, along the left side of the source list.

→ Scroll down to the bottom of the screen and click the Duplicate button (with the label “Select one or more items and perform an action”).

→ Follow the directions for copying a single citation once you reach the Copy Citations screen.

**Selecting a citation type**

**Available citation types**

NoodleBib provides assistance with citing nearly every type of citation discussed in the *MLA Handbook*, *APA Publication Manual*, and *Turabian’s Manual for Writers*.

**Coverage of The Bluebook:**

Forms available in APA Advanced for legal sources (statutes, court cases, etc.) go beyond what is described in Appendix D of the *APA Publication Manual*. For example, all of the forms allow you to indicate if the material was retrieved online (LEXIS, Westlaw, GPO Access, FindLaw, THOMAS, etc.). The information for these forms is derived from the *The Bluebook* (2005, 18th ed.).

**Selecting the correct citation type for your source**

A source can potentially “fit” under more than one citation type. For example, consider the articles that are included in Gale’s *Opposing Viewpoints* database. *Opposing Viewpoints* was originally a series of print books. Each book was a collection of articles (mainly reprints of newspaper and magazine articles) about a controversial issue. The print series is now available as a subscription database. To cite a magazine article reprinted in this database, you might select any of the following citation types:

1. Magazine (where the article was originally published)
2. Anthology / Book Collection (referring to the printed book)
3. Online Database (referring to the current form in an online database)
NoodleBib will guide you to the correct form no matter which of these three citation types you select. For example, if you were to select “Magazine,” you see:

Figure 9: "Magazine" selected as the citation type (MLA Advanced)

There are several elements on this screen that help you choose the correct path. Three possible options are presented, with the most common one under the heading “We think you probably mean….“ In our example above, the source is a reprint in a book, so we would choose that option. Near the top of the screen, a “Not sure?“ link provides the user with a detailed description of exactly what a magazine is. And “Examples“ links next to each choice allow you to compare your source against other similar sources (see the pop-up window in the picture).

Instead, if you chose “Online Database” or “Anthology / Book Collection“ (or even just “Book”), a similar screen helps you find your way to the correct form. For example, in the following screen for “Online Database” you could select “Magazine” (and then choose “Reprint” on the following screen).
Finally, you can ask us for help if you can’t decide how to cite a particular source. That is an important part of what makes NoodleBib unique among handbooks and other software!

**Form basics**

The form that you will complete to cite a source is dynamically generated from the information you supply. That means it shows you only the fields that apply to your specific source. Those fields change based on the style (MLA, APA, or Chicago/Turabian), the level (Starter or Advanced), the citation type you select, and your answers to the questions NoodleBib asks before you reach the final form (for example, the publication medium).
Figure 11: MLA Starter citation form (newspaper article in a database)

<table>
<thead>
<tr>
<th>Elements of the citation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Last Name, First Name Middle Name. &quot;Article Title.&quot; Name of Newspaper</td>
</tr>
<tr>
<td>Date You Viewed It. &lt;URL&gt;.</td>
</tr>
</tbody>
</table>

**Your citation**

- **Author(s)**
  - First name
  - Middle name
  - Last name (or organization)
  - Add

  - Chase, Kimberly

- **Article title**
  - Teachers Fight Against Internet Plagiarism
  - Capitalize the first letter of important words in the title

- **Name of newspaper**
  - Christian Science Monitor
  - Capitalize the first letter of important words in the name

- **Date of publication**
  - March
  - 2
  - 2006

- **Edition**
  - 4
  - For example, natl., late, or eastern

- **Page numbers**
  - 5C
  - For example, 5C or 3A+ (It continues on another page)

- **Name of database**
  - Academic Search Elite
  - *required

- **URL**
  - http://
  - The 7th edition of the MLA Handbook does not require a URL. Should I still provide one?

- **Date you viewed it**
  - August
  - 23
  - 2009
  - *required

For novice scholars, the MLA Starter form shows an example of a citation, then prompts you to enter information in the color-coded form below that. Basic instructions can be found alongside many of the fields, while more advanced help is often available via a small question mark button to the right of those fields.

When you work with Advanced source lists, citation forms are usually divided into sections in order to help you understand the data entry process. The form begins with a review of the choices you have already made (citation type,
Citing Sources

publication medium, online retrieval mechanism, etc.), to remind you of the information you have already supplied to get the particular version of the form that you are seeing. The **Basic information** section below it prompts you to start entering essential information about your source.

**Figure 12: MLA Advanced citation form (partial form shown)**

Additional sections of the form will be visible, depending on the citation type and the options you have already selected. For example, the form for an online source provides space for online retrieval information (e.g., Web site or database name, date of access, URL). Detailed instructions are printed to the right of each field, many with hyperlinks to advanced help. All forms end with an **Annotation** field in which you can compose descriptive or evaluative comments for each citation.
Citing Sources

**Required fields**

In MLA Starter, required fields show both an asterisk and the word “*required.*” In MLA, APA, or Chicago/Turabian Advanced source lists, the required fields are tagged with an asterisk, as in “*Title of book.*”

As a safeguard, NoodleBib will prompt you for required information if you do not enter it. Required fields enable your reader to find a source – a key reason for creating a bibliography.

**Name fields**

NoodleBib allows you to add any number of authors, editors, and other contributors to your citation.

*Figure 13: Field for adding names of authors and other contributors*

To add a name, enter the first, middle and last name and then a suffix (such as "Jr."). When you click the **Add** button, it will be included in the list of names. If you forget to click **Add**, the software will automatically add the name for you when you submit the form. If you make a mistake, you can click on the name in the list and click the **Remove Name(s)** button to remove it. You can also reorder the list of names, should you realize that you have not added them in the same order as they appear on the title page.

**Academic titles**

Titles such as "PhD" or "Dr." should not appear in your citation.

**Corporate authors**

If you are citing a corporate author (e.g., American Medical Association), or giving the name of a group (e.g., the band “Sting”), enter the entire name in the "last name or group/corporation" field and leave the other fields blank. Then click the **Add** button to include it in the list of names.
How many?
You may add up to eight names in this way. NoodleBib will automatically shorten the list of names for you according to rules of the citation style you are using. In MLA, if there are more than three names, only the first name will appear in the citation, followed by "et al." In APA, if there are more than seven names, only the first six names will appear in the citation, followed by "..." and the final name (see note under “What order?” below). In Chicago/Turabian, if there are more than three names, the note form of the entry contains the first name followed by “et al.” whereas the bibliography form of the entry lists all of the names without abbreviation.

What order?
Names should be listed in the same order as they appear in the source credit (for example, on the title page in a book or on the credit screen of a movie). You can move a name up or down in the list once you've added it by clicking on it in the list (to select it), and then using the up and down arrows next to the list.

Note: If you are creating an APA citation with eight or more contributors, give the first seven in the order they appear, and then enter the last contributor in the eighth spot.

Checking for common errors
Until you become an expert on capitalization and abbreviation rules, we strongly encourage you to click the Check for Errors button at the bottom of the citation form before you generate or update a citation. This feature will quickly scan your input on the form and alert you to common style errors, so that you can be sure that your source list is polished and complete.

Checking for errors
→ Fill in form fields with as much detail as possible, including all required fields.
→ Click Check for Errors at the bottom of the form.
→ The form will reload with a message at the top of the screen indicating the check is complete.
→ Scroll down the form, looking for red error messages.
→ Follow the directions to correct any mistakes.
→ Click Update Citation when satisfied.
Parenthetical reference help (MLA and APA only)

A “Parenthetical Reference” link next to each citation that you create opens a pop-up help screen that shows how to create the correct parenthetical (“in-text”) reference for that specific entry.

Figure 15: Parenthetical Reference (i.e., in-text reference) help link

Depending on the source, this help screen may prompt for a page or volume number in order to customize the example so that you can copy and paste it directly into your paper.
Citing Sources

Figure 16: Parenthetical reference help

MLA Parenthetical Reference

Example for your source
A parenthetical reference to this Journal might look like this:

...the end of your sentence (Baetens 45).

To customize this example, enter the following information:
Page number(s): 45 e.g., 150-69

Scroll down below the example to read detailed instructions that guide you through special cases and other modifications to the parenthetical reference that might be necessary depending on the rest of your sentence and the other entries in your source list.

Labeling primary, secondary and tertiary sources

Each entry in your bibliography can be described as a primary, secondary or tertiary source. Once you have labeled entries, you can sort the source list so that all of the primary sources are grouped together (sorted alphabetically), followed by all of the secondary sources and then the tertiary sources.

Figure 17: Dropdown menu for classifying sources

Applying descriptions to citations

Only one description can be applied to a citation. This prevents you from making a mistake such as associating both “primary source” and “secondary source” to a single citation. If you apply the description “secondary source” to a source that was already labeled “primary source,” the new description (“secondary source”) will replace the old one.

Applying a description to one or more citations
→ On the **Bibliography** screen, mark the checkboxes next to the citations that you wish to label.

→ In the **Description** dropdown list at the bottom of the screen, select “primary source,” “secondary source,” or “tertiary source.”

→ Click the **Apply** button.

→ The label will appear in the **Description** column of your source list for each of the entries that you selected.

![Figure 18: “Secondary sources” label applied to a citation](image)
Removing descriptions from citations

Removing a description from a citation

→ On the Bibliography screen, mouse-over the text in the Description column next to your citation. A context menu titled Options will be displayed.
→ Click Remove the attribute “[Primary/Secondary/Tertiary] source” from this entry.

Sorting source lists in alternative ways

By default, NoodleBib orders your source list alphabetically (using letter-by-letter alphabetization). Each of the style guides has slightly different rules for alphabetizing. Unless your instructor specifically requests otherwise, a source list should always be submitted using NoodleBib’s default sort order. However, it can be revealing and instructive to be able to group or sort your list in other ways. There are three alternative ways to view and print your list:

1. **Currency**: Citations are ordered in descending order of publication or copyright date (most recent first). Sources for which no date is known or provided are listed at the bottom when this sort order is selected.
2. **Media type**: Citations are grouped into general, pre-defined groups indicating the type of publication: Periodicals, non-periodicals, audio-visual material, Web sites and other e-sources, legal sources, and unpublished/other. Within each of these groups, entries are ordered alphabetically.
3. **Primary, secondary and tertiary**: Citations are grouped based on whether they have been labeled by the user as a primary, secondary, or tertiary source. Unlike the other views, citations that have not been labeled by the user are omitted from view.
Figure 19: Sorting a source list by media type

Sort order is maintained when you save your source list as an RTF file via the **Save as Word Doc** option. Category titles are displayed in green with a light brown background.

**Printing citations**

**Formatting**

Before you export your source list and open it in your word processor, NoodleBib allows you to do some basic formatting. To see the formatting options, click the **Print** button in the options panel above your source list (in the **Bibliography** screen).

**Changing the title**

By default, MLA lists are titled “Works Cited,” APA lists are titled “References,” and Chicago/Turabian lists are titled “Bibliography.” These are the most common titles, but your may want a title that more accurately reflects the contents of your particular source list. For example, if you have added
annotations to your MLA list, a more descriptive title would be “Annotated List of Works Cited.”

→ Click the Print button.
→ Under Formatting Options, click the link next to “List Title.”
→ If you are creating an MLA style list, select one of the titles from the examples listed by clicking on the associated hyperlink, or create your own title by typing a title in and clicking Set Custom Title.
→ If you are creating an APA or Chicago style list, no preset alternatives are provided. Simply type your own title in and click Set Custom Title.

Adding a header (MLA and APA only)
A “header” is information that appears at the top of each page of your paper. The MLA Handbook indicates that the header at the top of your source list should consist of your last name followed by a space and the page number. The APA Publication Manual states that the header should consist of a shortened version (2-3 words) of the title of your paper, followed by 5 spaces and the page number. If you are not writing a paper that will be published, a header is generally not required (you can ask your teacher if you aren’t sure). NoodleBib can add the header to your source list for you, correctly formatted (although you will still need to make sure that it also appears throughout your essay).

→ Click the Print button above your source list.
→ Under Formatting Options, click the link next to “Page Header.”
→ If you are creating an MLA style list, enter your last name and click Set Header.
→ If you are creating an APA style list, enter a shortened version of your paper’s title and click Set Header.

Underlining vs. italics (MLA only)
The 7th edition of the MLA Handbook suggests that italic type should be used as long as the text is readable in your chosen font. By default, NoodleBib uses italics in your source list. However, your teacher may instruct you to use underlining if the italic type is difficult to read.

→ Click the Print button about your source list.
→ Under Formatting Options, click the link next to “Italics/Underlining.”
→ Click the link that reads “Switch to underlining.”
→ All entries in your list will be automatically updated to use underlining. You can return to this screen to convert back to italics, if necessary.
Keep in mind that this affects only the list that is open. Other lists in your personal folder will not change.

**Annotation spacing (MLA only)**
The *MLA Handbook* recommends that annotations be typed directly after citations, without any separation (see example in section 5.3.1 of the *MLA Handbook*). By default, NoodleBib displays annotations in this manner. However, your teacher may instruct you to separate annotations with an extra vertical space, for readability.

→ Click the Print button above your source list.
→ Under Formatting Options, click the link next to “Annotation Spacing.”
→ Click the link that reads “Start annotations on a new line.”
→ All annotations in your source list will be automatically updated. You can return to this screen to convert back to the default formatting, if necessary.

Keep in mind that this affects only the project that is open. Other projects in your personal folder will not change.

**Including or omitting annotations**
If you have included annotations in your source list but you do not wish them to appear in the version you print or export to Word, you can omit them:

→ Click the Print button above your source list.
→ Under Formatting Options, click the link next to “Include.”
→ Click the link that reads “Print citations only (omit the annotations).”
→ Note that your annotations will no longer appear in your source list, even though you can still edit existing or add new annotations. You can return to the Formatting Options screen if you would like to make them visible again.

**Other formatting**
To change other document formatting, such as fonts and line spacing, wait until your source list is complete and then make the changes after you have imported your source list into your word processing program (see next section).

**Adding your source list to your research paper**
When you are satisfied that your source list is accurate and complete, you can import it into your word processing program and append it to the end of your research paper.
Citing Sources

Note: Formatting will be lost if you attempt to copy and paste your source list from the NoodleBib screen to your document.

To add your source list to your research paper

→ On the Bibliography screen, click the Save as Word Doc button. Microsoft Word is often used, but source lists can be opened in any word processor that supports the RTF file format standard (nearly all word processors do).

→ On the Print screen, verify the settings under Formatting Options are correct and then click Export and Print.

→ A screen titled Export as RTF/Open in Word will be displayed, followed by one of these three events:

1. If your computer is configured to open Word or another word processing program automatically, your source list may immediately open within that word processor. This may or may not be the word processor that you have used to write the rest of your research paper (see Opening the RTF file in the right word processor in this chapter). Regardless, to save the source list, use that word processor’s File → Save as... mechanism to save the document as you wish (for example, in Word, as a .doc or .docx file), to a location on your computer or network that you will remember.

2. If your browser is configured to prompt you before opening the file, a browser pop-up window will appear asking you whether you would like to save or open the file. Select the option to save the file and save it as an RTF file to a location on your computer or network that you will remember.

3. A security message may notify you that the browser has blocked the site from downloading the file. Click the message and allow the download, then follow options 1 or 2 above.

→ Now that the source list has been saved in RTF format to your computer or network, open both your research paper and the new file that contains your source list. Copy and paste your source list from its word processing document to the end of your research paper in the second word processing document. It is customary to begin your source list on a new page, not on the last page of your research paper.
Opening the RTF file in the right word processor

Your computer may have a particular application associated with files that are in RTF format. When you use the **Print** feature in NoodleBib (or **Open as Word Doc**) to open or save your source list as an RTF file, your computer may automatically open the file using this application. This may not be the application you want to edit the file with.

For example, the file might be opened in a text editor like textedit that does not fully support the RTF standard. The consequence is that formatting can be lost. Alternatively, you might have multiple word processors on your computer (e.g., Word, AppleWorks, WordPerfect) but the file gets opened in the wrong one.

To force RTF files to open in the application you want, follow these steps:

**On a Mac:**
1. Use **Open as Word Doc** and save the file to your desktop. If it doesn't give you the option to save, let it open the file in the default application (often textedit) and then use that application's **File ➔ Save As...** option to save the file to your desktop.
2. Single-click on the file on your desktop to highlight it and select **File ➔ Get Info**.
3. Click the **Open With** tab and change the value in the dropdown list to Word, AppleWorks, or whatever application you wish to use to edit RTF files.
4. Click **Change All** so that all RTF files are opened using this application in the future.

**On a PC:**
1. Use **Open as Word Doc** and save the file to your desktop. If it doesn't give you the option to save, let it open the file in the default application (often textedit) and then use that application's **File ➔ Save As...** option to save the file to your desktop.
2. Right-click on the file on your desktop and select **Open With...**
3. Select the correct word processing application from the list (or click **Browse...** to find the application if you do not see it in the list)
4. Check **Always use the selected program to open this kind of file.**
5. Click **OK**.

**A note about WordPerfect and hanging indents**

When you save your source list out as an RTF file from NoodleBib and then open that RTF file in WordPerfect, you'll notice that the hanging indents are missing.
We've researched this issue and it turns out that this is a bug in WordPerfect's handling of RTF files. Hanging indents are lost when you import an RTF file into WordPerfect. Be sure to add hanging indents manually before you print your final copy:

1. Highlight the entire document
2. Select Format → Paragraph → Hanging Indent

Printing

The final version of your source list should always be printed from your word processor. Do not print your source list from the Preview screen (described in the next section) because the HTML version is not perfectly formatted – it is only a close approximation of the correct spacing and formatting.

Previewing as a Web page

Although you should always use the Save as Word Doc option described in Adding your source list to your research paper and print your list from Word, NoodleBib does give you the ability to preview your formatted source list as an HTML-based Web page.

To preview your source list

→ On the Bibliography screen, click the Print or Save as Word Doc buttons.
→ Click Preview.
→ A new window will be opened containing just your source list. If no window appears, disable your pop-up blocker and retry.

Use this view of your source list if you wish to put a copy on a Web page. Use the browser’s File → Save as... mechanism to save what you see in the preview window as an HTML file on your computer or network.
What are notecards?

The notecards feature in NoodleBib is designed to help you extract, organize and synthesize information you find during the research process. NoodleBib’s notecards are “e-index cards” with some important advantages. You can:

- Access your notes from any computer via a Web browser
- Capture any digital information (e.g., quotes, images, diagrams, tables) from the Web
- Link your notes to your sources to avoid accidental plagiarism
- View your notes alongside your bibliography entries in order to assess the value of each resource
- Create notes of your own ideas not linked to any source (“thought cards”)
- Label notecards with word or phrase “tags” that represent concepts or facts you want to keep track of
- Color key your notecards for quick visual identification
- Add visual cues to your notecards as reminders (each cue has a predefined meaning, such as “incomplete,” “need help,” or “used in paper”)
- Search your notecards by keyword, tag, or source association to view and organize notes in multiple ways
- View, arrange and organize notecards on a virtual tabletop quickly and easily
  - Mouse-over notecards for a quick summary of the content
  - Drag individual cards into piles to develop a main idea
  - Order cards within piles to develop a logical argument
- Create an outline and move individual notecards or piles into topics or subtopics
- Export both your notecards and outline to a word processor where they can be edited and printed
- Share both the notecards and outline with your instructor

Overview

Access to the notecards feature

All subscribers have access to the notecards feature. The free version, NoodleBib MLA Starter, does not include access to notecards.
Administrators can control users’ access to notecards according to local school needs. By default, the notecards feature is enabled in NoodleBib. However, an account administrator may turn the feature off by logging in to the subscription management area and clicking the NoodleBib Customization link.

To determine whether or not you have access to the notecards feature, simply log in to NoodleBib and click Notecards in the navigation bar. If the feature is not available, a message will be displayed explaining the limitation.

Notecards

Once you create and open a new project in NoodleBib, there are two ways to access the notecards feature: the Notecards and Bibliography screens. Since you can view and edit all of your notecards in either screen, you’ll find that you develop a preference for working in either the Notecards or Bibliography screen as you take notes.

Options available from either screen:

1. Create, edit, delete, and export/print notecards
2. Tag notecards with words or phrases that represent important facts or ideas
3. View notecard comments (or add/edit/delete notecard comments if you are an instructor viewing a shared project)

Clicking Bibliography in the navigation bar takes you to your list of citations. In the Notecards column next to each citation, you’ll find a New link that allows you to create a new notecard. If a citation is already associated with notes, you will see the number of notecards you created and a Show link to view the notecards below the citation.

Options available only from the Bibliography screen:

1. Quickly display the notecards for a particular source to help you assess the value of the source or to remind you if you have finished taking notes
2. Show or hide notecards depending on your needs, via the Notecard display links near the top of the screen. The “Show only notecards that have comments” option is the primary mechanism for a student to view new notecard comments from an instructor.
3. Full details of the notecards are always shown
4. Both notecard comments and citation comments can be viewed (or added/edited/deleted) from this screen
When it comes time to organize and outline, click on **Notecards** in the navigation bar to see the **Notecards** screen.

**Options available only from the Notecards screen:**
1. Create, edit, and delete notecard piles
2. Organize notecards on a virtual tabletop via drag-and-drop
3. Organize a “pile” of notecards under a main idea
4. Order notecards within a notecard pile
5. Add or delete color tags and visual cues
6. Rename and delete word/phrase tags
7. Search notecards by keyword, tag, or source association
8. Export/print notecard piles, a group of selected notecards, or all notecards
9. Create an outline
10. Associate notecards with topics or subtopics in the outline via drag-and-drop
11. Export/print the outline alone, or with the contents of your notecards

**Approaches to note-taking**

The components of the note-taking software are anchored in the best practices of academic research and inquiry learning. At the same time, the software has been designed flexibly in order to support both individual note-taking preferences and a variety of teaching styles.

- Already have a good sense of the structure of your research paper? Identify the main ideas that you want to address and begin to group notecards into piles for each idea on the **Notecards** screen.

- Unsure of how to organize the information you are finding? Remain on the **Bibliography** screen to add sources and notes. Don’t worry about organizing and piling them into main ideas yet. Tag each notecard with concepts, descriptive words or phrases that you can use later to identify potential piles.

- Investigating different ways of organizing your paper? Search on different keywords and tags on the **Notecards** screen to discover related notecards. When you are satisfied with a grouping, create a pile with the selected notecards by clicking the **Add to Pile** button. Experiment with ordering notecards within a pile until you are satisfied with the logical order or have identified information gaps you need to fill. Tag each notecard with descriptive words or phrases that you can use later to identify potential piles.
• Have thoughts and questions as you are extracting a quotation? First explain and summarize the quote or chart in your own words, since this will help you understand it better. Then use the My Ideas field to synthesize the information, reflect on what you’ve learned, and ask questions about what you don’t understand or want to investigate next.

**Working with notecards**

**Note-taking skills enabled by this software**

Notes are tools for thinking, not forms to complete. They document what you already know, help you explain what you are reading so that you will understand it thoroughly, and keep a record of important ideas you unearth (or creative thoughts that occur to you).

Tagging, organizing and grouping your notes into piles can show you patterns or trends, enable you to join critical elements from different sources, and help you identify redundant or irrelevant notes that you can delete. By rereading and experimenting with various arrangements of your notes and piles, you will clarify the focus of your investigation, discover patterns and trends across sources, develop a logical order for your ideas, and tag solutions within a series of causes and effects.

Your notecard piles can support the development of any product you need to create. Eventually you can add them as a group to a subtopic in the outline of your essay, or they can become the framework of your debate speech and rebuttal arguments, the plot structure of your historical narrative or the main ideas and supporting evidence for your persuasive letter.

To guard against accidental plagiarism, we suggest that you cut-and-paste the actual words or images on a notecard before you try to summarize or paraphrase your source’s idea. This will assure that you will always be able to reread or review the author’s words and logic even after you have returned a book or closed a Web page.

Put one idea on one notecard. You can split one card into two by cutting-and-pasting part of a quote into a second card, if you discover more than one idea on a card. Record the actual page or URL of the quote, not the range of pages for the source.

Take the time to reread and think about and even mark up the author’s words with highlighting, bolding and colors; the better you understand the quote, the
easier it will be to paraphrase or summarize the author’s idea. Be aware of your thoughts and feelings and record them in My Ideas, as these are the responses that help you develop a personal perspective. The more you think about your investigation, the more satisfying and interesting your investigation becomes.

If you are asked to annotate your source list or if you need to weigh one source’s contribution or qualities with another, view your notes by source (from the Bibliography screen) and read through them as a group, since it will help you assess the value of the source and compare it to others.

When you scan your source list you will notice that some sources have significantly more notecards than others. Ask yourself why -- it will help you evaluate the value of your sources and even monitor your own progress. For example, if you notice that one source only has a single notecard, it might remind you that you were interrupted when taking notes and had intended to continue later. Or, when you compare the notes for one source with another, you might recognize that one source is particularly useful for an overview of the topic, while another has been written by an expert whose research focused on one aspect of your topic. This knowledge can be useful when you want to reinforce a conclusion you make ("Kermit, whose knowledge of frogs comes from deeply personal experience, confirms my hypothesis that..."). As you critically annotate your sources, your source list view of your notecards can remind you of particular strengths or gaps in information ("While this author is not concerned with environmental threats...").
The Notecard Tabletop

The Notecard Tabletop is a new way of visualizing and organizing large numbers of notecards that combines the ease and flexibility of working with paper notecards on a desk with the advantages of saving those notecards online.

Navigating the tabletop

Figure 20: Notecards screen

The tabletop itself extends beyond what you see on the screen, giving you room to space out and organize your notecards. Click-and-drag the white area of the tabletop (A) to view different parts of the tabletop on your screen. If you need additional tabletop work space, the Outline panel (B) can be minimized when you don’t need it by clicking the small arrow button on the top-right corner.

A birds-eye-view at the bottom-left of the tabletop (C) allows you to see and navigate the entire tabletop, with your current view represented as a blue box. Small light gray squares represent notecards. If you add a color tag to a notecard, the birds-eye-view representation of that notecard will also be displayed in that color. Black squares represent notecard piles. Drag the blue box around in the birds-eye-view to navigate quickly to other areas of the tabletop.
Creating and manipulating notecards

Creating a notecard

Notecards can be created from either the Bibliography or Notecards screen. However, if a notecard is created from the Bibliography view, it is automatically associated with a particular citation. A “thought card” (a notecard that contains your own thoughts or a reminder to yourself, not tied to any citation in your source list) can only be created from the Notecards screen.

Creating a new notecard

→ From the Bibliography screen, click the New link in the “Notecards” column of the source...

Figure 21: Creating a new notecard (Bibliography screen)

→ ...or from the Notecards screen, click the New Notecard button (top-left of the Notecard Tabletop).

Figure 22: Creating a new notecard (Notecards screen)

→ The New Notecard window will be displayed.
Provide:

→ A title – typically 1-3 words that identifies the topic of the note. **Note:** Titles should be unique so that you are reminded of the content of the notecard when you see an abbreviated summary in the mouse-over view.

→ The source of the note (if any). Citations that you have already created can be selected from a dropdown list of your sources. When you create a new notecard from the Bibliography screen, you will not see this source field, since the notecard is automatically associated with the entry you are working with.

→ A URL (if applicable). This may or may not be the same URL that you actually use in your citation. For example, if the URL is very long and complex, the style rules may not want you to include it in your citation, but it would be useful here on your notecard, to allow you to access the resource quickly.

→ Pages from which the quotation is retrieved (if applicable).

→ Tags (see the Notecard tags section later in this chapter for instructions).

→ A direct quotation. If your source is a Web document, simply copy and paste the material directly from the Web page. On a PC, you can do this...
by highlighting the material on the Web page and typing Ctrl-C, then clicking in the text area on the **New Notecard** screen and typing Ctrl-V.

→ Optionally, you can scroll down and add information into the **Paraphrase** and **My Ideas** fields (see “Approaches to note-taking” earlier in this chapter). A **spell-check button** is available in the tool bar of each text field to assist you with spelling.

→ Click the **Save** button.

→ Notecard names should be unique – if the new notecard title already exists, you will be prompted to choose a different title.

→ Your new notecard will be saved.

→ If you are creating the notecard from the **Bibliography** screen, the screen will automatically scroll so that you can view the new notecard...

→ ...or if you are creating the notecard from the **Notecards** screen, a graphical representation of the new notecard will appear in the “New Notecards” region of the tabletop (top-left). Drag the notecard out of the “New Notecards” region onto the tabletop (or click the **Move 10** button directly below the “New Notecards” region to move ten at a time), where you can group it with similar notecards, add it to a notecard pile, etc.

---

**Figure 24: New Notecards region**
Editing a notecard

Once you have created a notecard, you can edit it in order to change the title, source, URL, pages, tags, quotation, paraphrase, and my ideas. To edit the notecard from the Bibliography screen, click the Edit button (Edit) in the top-right corner of the notecard. To edit the notecard from the Notecards screen, hover your mouse over the notecard on the Notecard Tabletop and click the Edit link in the pop-up summary of the content.

Figure 25: Notecard summary pop-up

Linking notecards to sources

When you create a notecard from the Bibliography screen, it is automatically associated with the source that you are working with. If you create a notecard from the Notecards screen, you must select the source from a dropdown list when you are creating the notecard.

When you edit an existing notecard (from either the Bibliography or Notecards screens), you can change this association by selecting a new source from the Source dropdown list on the edit screen.

To change the source association of several notecards at once, highlight (control-click) the notecards you wish to change on the Notecards screen and then click the Link to Source button.
**Viewing notecard details**

Although it may not seem intuitive at first, the Bibliography screen is the easiest place to view the entire contents of your notecards. Since the Notecards screen is primarily intended to assist you in visually manipulating and organizing large numbers of notecards into and out of piles, and organizing them into your outline, it is not possible to display the full content of the notecards in this view. In contrast, on the Bibliography screen, the full details of that notecard are always visible.

The Bibliography screen also has some useful shortcuts that allow you to show or hide groups of notecards that you are interested in. First, each citation in your source list that has one or more notecards associated with it has a Show link in the Notecards column that you can click to display all of the notecards for that one. At that point the link changes to Hide so that you can reverse the action when you are done.

Below the button bar on the Bibliography screen (and above your source list) are the Notecard display options.

**Figure 26: Notecard display options**

![Notecard display options]

**Show/hide all**: If all notecards are currently hidden, all notecards are shown. If one or more notecards are currently shown, all notecards are hidden.

**Show/hide thought cards**: Shows or hides the notecards that you have created that are *not* associated with any citation in your source list (“thought cards”). These notecards are displayed directly below the Notecard display bar (above the first citation in your source list).

**Show only notecards that have comments**: Displays all notecards that have comments from an instructor (and hides all other notecards). If the My Projects screen indicates that your instructor has written new comments to you, this view allows you to see all notecards (and citations) with new comments (visually scan for the yellow “New” graphic next to the new comments).

Sometimes it may be necessary to view the full details of a notecard from the Notecards screen. Hover your mouse over a notecard to see a summary view containing the title, the source, a Web link, and snippets of the tags and quotation. From there, you may click the View Details link to bring up the full
contents of the notecard (as well as any comments that have been written on that notecard by an instructor).

**Deleting a notecard**

Deleting a notecard

→ From the Bibliography screen, click the Delete button (>Delete) in the top-right corner of the notecard.

→ From the Notecards screen, you can either:

→ hover the mouse over the notecard on the Notecard Tabletop and click the Delete link in the summary pop-up that comes up.

→ Control-click on notecards to highlight them, then click the button with the red “X” at the top of the screen to delete the highlighted notecards.

→ Click Yes when asked if you wish to delete the notecard(s).

**Undeleting a notecard**

Deleted notecards can be recovered by clicking the Recycle Bin button (твержда) above the Notecard Tabletop. A Restore Deleted Notecards window will appear that allows you to select the notecards that you wish to undelete.

![Figure 27: Undelete notecards](image)

**Note:** Notecard piles are not restored. If a notecard was in a pile when it was deleted, the notecard will be restored as a stand-alone notecard on the Tabletop when it is recovered.
Renaming a notecard
The simplest method of changing your notecard title is to click on the notecard’s title on the tabletop, enabling you to edit that field. After you edit the title, click outside the title (or press Enter) to save the change.

Creating and manipulating notecard piles

What is a notecard pile?
A pile is a group of notecards that share a common theme, support an idea, or center on a particular topic. A notecard may only belong to a single notecard pile. On the Notecards screen, a pile is represented as a stack of notecards with a number on the front that indicates how many notecards are contained in the pile (see the Viewing and modifying a notecard pile section in this chapter for how to view those individual notecards).

Creating a notecard pile
Unlike notecards, notecard piles can only be created and manipulated on the Notecards screen.

Creating a new pile via drag-and-drop (for piling 2 notecards)
→ On the Notecards screen, drag-and-drop one notecard onto another notecard on the Notecard Tabletop.
→ A New pile window will appear, prompting for the pile title. Enter a brief title and click the OK button.
→ Pile names should be unique; if the new pile title already exists, you will be prompted to choose a different title.
→ The two individual notecards will be replaced on the tabletop with the new pile.

Creating a new pile via the Add to Pile button (for piling many notecards)
→ On the Notecards screen, Control-click on notecards and/or notecard piles on the tabletop that you wish to combine into a new notecard pile. The selected notecards and piles will appear highlighted in yellow.
→ Click the Add to Pile button at the top of the Notecards screen.
→ On the pop-up window, select the **Create New Pile** option and provide a new pile title.
→ Click **Submit** and the new pile will be created in the “New Notecards” region. Drag-and-drop the new pile from there onto the tabletop where you would like it.

**Viewing and modifying a notecard pile**

Once a notecard pile has been created, simple drag-and-drop actions allow you to add and remove notecards, combine piles, and move notecards between piles. For example, to combine two piles, simply drag-and-drop one pile onto another. To add a notecard to an existing pile, drag-and-drop the notecard on top of the pile you wish to add it to.

Notecard piles can be expanded on the tabletop so that you can work with individual notecards within the pile. To expand a notecard pile, hover your mouse over the pile and click the **Expand** link in the summary pop-up. The expanded pile is represented on the tabletop as a dotted rectangle as shown here.

![Figure 29: Expanded notecard pile](image)

To remove a notecard from a notecard pile, simply click on a notecard in the expanded view of the pile and drag-and-drop it outside of the dotted rectangle that represents the pile. Or, if you want to add it into a different pile, drag-and-drop the notecard onto another pile on the tabletop.

To view the full content of all of the notecards in a pile, click the **View Details** link in the expanded view of the pile.
When you are done viewing and making changes to the notecard pile, click the **Close Pile** link to return the pile to its original state.

**Deleting a notecard pile**

A pile can only exist if it contains two or more notecards. Thus, if a pile contains two notecards and you drag-and-drop one notecard out of the pile, the pile will disappear. Piles may also be automatically removed as a result of any action that results in an empty or single-notecard pile (e.g., the **Add to Pile** and **Delete** buttons).

If you delete an entire pile, you will also be deleting all of the notecards it contains. To delete a pile and its notecards, mouse-over the notecard pile and click the **Delete** link from the summary pop-up. Click **Yes** when asked “Are you sure you want to permanently delete this pile and the notecards within it?”

**Renaming a notecard pile**

To change a pile’s title, click on the notecard pile’s title on the tabletop. This will place the title in edit mode. Change the title and click outside the title (or press Enter) to save.

**Reordering notecards within a notecard pile**

Reordering notecards

→ Hover the mouse over a notecard pile and click the **Expand** link to display the expanded view of the pile.

→ Click on a notecard within the pile and drag-and-drop it to a new location within the pile. Notecards in the pile will automatically move aside as necessary to allow you to insert the notecard between them.

**Notecard tags**

What is a tag?

A tag is a way for you to identify and label concepts within each notecard. As you take notes, you can continually add and edit tags, both tags you’ve already used and new ones that you create. Later you can easily sort by a particular tag/concept across all your notecards.

Unlike a notecard’s title which corresponds to the main idea of one notecard, tags represent other important ideas or details within a notecard. As you investigate your topic, you will notice that your are assigning certain common tags to notes from different sources. This new association of notes might suggest to you that you should create a new notecard pile containing these notes or
insert these notes into a new or existing subtopic in your outline. You may realize you are identifying evidence or data for an argument you want to make.

Tags can be either keyword tags (e.g., *climate*, *food*, *eyes*, *adaptability*, *tongue*, *skin*) or phrase tags (e.g., *chemical_threat*, *climate_threat*, *construction_threat*, *fungus_threat*, *habitat_loss*, *life_cycle*).

Tags have the following attributes in NoodleBib:

1. Any number of tags can be added to a particular notecard.
2. A particular tag can be assigned to any number of notecards.
3. Tags are separated (delimited) by spaces.
4. Multi-word tags must be enclosed in quotation marks (e.g., “chemical threat”) or joined by an underscore (e.g., chemical_threat) so that they will not be treated as two separate tags.
5. Tags are unique to a particular project. If you want to use the same tag in a new project’s source list, you must add it again.

**Why are tags useful on notecards?**

As you read, investigate and take notes, you discover facts, ideas, themes and data that you suspect may be important, and that you want to remember and collect. Tag them, so that you can find them again. At any point you can quickly locate notecards contain a tag you create, or even locate all your notes that contain two or three tags in common.

Tags can help you gather organize, analyze, evaluate and even synthesize different aspects of the information you collect. For example, in our tags on frogs, we may eventually gather and organize several environmental threats (*chemical_threat*, *fungus_threat*, *climate_threat*, *construction_threat*, *habitat_loss*) for a discussion on declining frog populations. Or, when we analyze the tags we have used about the frog’s physical features (e.g., *eyes*, *tongue*, *skin*), we may realize that we probably need information about other parts of the frog’s body (e.g., *legs*, *digestive system*) and decide to search for new sources.

Sometimes we take notes on a news article about the results of a research study, the abstract of a scientific paper or an executive summary of a foundation’s report. We may add a tag with the name of the study or report. As we evaluate our notes on this source, we may realize that we ought to find and read the entire report or the original study, since it will include the details, examples and explanations that will expand and elaborate the ideas we recorded.
Eventually we may realize that notecards with certain tags should be grouped as a pile called “environmental threats.” Or, when we group the notecards by the skin tag, we may discover connections among complex biological attributes; the frog’s skin keeps it moist and allows it to breathe, but it also absorbs dangerous chemicals and carries disease to other frogs.

When you first begin to read about a subject, you may not know what to tag. It becomes easier to go back and tag notecards after you have a better understanding of your subject. Tags help you focus your thinking, support claims with evidence, uncover the big picture and compare different ideas in order to synthesize information. It is precisely this flexibility that makes tags such a useful tool for thinking.

**Associating tags to notecards**

To associate a tag with a notecard as you create it, simply type the tag into the Tags field on the New Notecard screen (see the *Creating a notecard* section earlier in this chapter). If a tag already exists, it will be listed below the tag entry field in the Existing Tags dropdown list. To associate an existing tag with the notecard, simply select a tag from the dropdown list to add that tag to the text that is already typed in the tag field. If the tag has already been added to the notecard, it will not be added again.

You can always add or remove tags from a notecard later by editing the notecard and changing the tags in the Edit Notecard window. However, it is faster to add and remove tags using the Tags button on the Notecards screen. This feature also allows you to add or remove a tag from several notecards at once:

**Adding or removing tags from one or more notecards**

- Control-click on the notecards you wish to add or remove the tag from. They will be highlighted yellow.
- Click the Tags dropdown button at the top of the screen, select the “Tags” option to display the list of existing tags, mouse-over the tag that you wish to add or remove, and select Apply or Remove as shown:
Figure 30: Adding word/phrase tags

Note: Tags are not case-sensitive. Capitalization is ignored, so for example the tag “Washington DC” is equivalent to “washington dc”.

Renaming and deleting tags
To rename or delete an existing tag, click the Tags button on the Notecards screen, then select the “Edit/Delete Tags” option at the bottom of the dropdown list. From the resulting screen, you can rename individual tags, or select one or more tags to permanently remove.

Notecard colors and visual cues
In addition to word and phrase tags, NoodleBib allows you to add colors and visual cues to the notecards you create.

Colors
Colors (red, orange, yellow, green, blue, and purple) have no predefined meanings; you decide what you want them to represent. They are applied in a manner similar to tags.
Adding a color to a notecard

→ **Control-click** on each of the notecards you wish to add or remove a color from. They will be highlighted yellow.
→ Click the **Tags** dropdown button at the top of the screen, select the “Colors” option to display the six color choices, mouse-over the color that you wish to add or remove, and select **Apply** or **Remove**.

![Figure 31: Notecard colors](image)

Unlike tags, only a single color can be applied to a particular notecard. If you apply the color red to a notecard that already has the color green, the notecard color will be changed from green to red. On the tabletop, notecard colors are represented by a small colored dot on the top-left corner of the notecard. The birds-eye-view also displays a colored square, rather than the default gray one.

One application for colors is labeling pro and con arguments for a debate (green for pro arguments, red for con arguments). Or if you were comparing three different versions of the same myth in various sources, you might choose to assign one color to notecards pertaining to one version, a second color for the second version, and so forth. Later, you can search your notecards by a color and certain tags, compare common attributes among all three myths, then pile and order notecards with a particular combination of color and tags on the tabletop or insert them into your outline under a new subtopic.
Visual cues

Visual cues are a set of six predefined visual reminders that can also be added to your notecards: Needs further research, Need help, Incomplete, Original thinking, Important, and Used in paper.

Figure 32: Notecard visual cues

When applied to a notecard, these visual cues show up directly on the notecard icons on the tabletop, calling them to your attention immediately.

Figure 33: Visual cues on notecards

Searching notecards

The Search feature at the top-right of the Notecards screen allows you to find the notecards that are linked to a specific source in your bibliography, or that have keywords, tags, a color, or visual cues that you are interested in.
The figure above shows an example of a search for all notecards that have both the keywords “habitat” and “destruction.” The **and/or** option next to the search field allows you to search using Boolean AND (all words must match) or OR (match any of the words). This keyword search looks for matches in the title, URL, pages, quotation, paraphrase, and my ideas fields of your notecards.

After you click **Search**, the notecards that match the criteria will be selected (displayed on the tabletop with a yellow highlight). If some notecards had previously been selected and highlighted, you will be asked whether you would like to replace the selection with the results of the search or append the new search matches to your existing selection.

After you conduct a search, the number of matching notecards can be determined by looking at the “notecards selected” count on the top-right corner of the Notecard Tabletop.

The results of a search can help you organize your notecards efficiently. For example, you might want to create a notecard pile with all notecards that have the tag “habitat.” To do so, simply search by tag “habitat” to select those notecards, and then click the **Add to Pile** button to create a new pile containing those notecards.
Printing notecards

To print notecards

→ On the Notecards screen, click the Print button above the Notecard Tabletop.
→ Choose “Export as Web page (HTML file)” or “Export to Word (RTF file)” from the options window, depending on your needs.

Important: Exporting and printing from a Web page will keep all of the images and formatting in your notecards intact. Exporting to an RTF file will eliminate all graphics and formatting (the result is just plain text).

→ Choose from three print options:
→ Export all notecards
→ Export selected notecards only (use control-click to select individual notecards on the tabletop, or search by keyword, tag, etc. to select notecards matching specific criteria)
→ Export notecards from pile... (choose a pile name from the dropdown list)
→ On the Notecard items to print window, choose the elements from the notecards that you wish to include in the exported file (quotation, paraphrase, my ideas, page numbers, etc.). By default, they will all be included. Unmark the checkboxes next to any elements that you wish to omit. Click the Submit button.
→ If you are exporting as a Web page, the Web page will open and you can use your browser’s File → Print mechanism to print the notecards.
→ If you are exporting to an RTF file then depending on the browser you are using, the file download will either start automatically, or you will be prompted to click a link to start the file download. Save the RTF file to your computer and then open it in Word (or other word processor that supports the RTF file type).

The Outline

Creating an outline

The right panel of the Notecard Tabletop is where you create an outline for your paper. The Outline panel can be minimized if you aren’t working on your outline and you would like additional space to manipulate your notecards on the tabletop. Click the small arrow button in the top-right corner to minimize the panel or to show it again.
Why use an outline?
An outline organizes your information in complimentary ways because it shows both:

1. The logical **progression** from your introduction/beginning through a conclusion/end in support of your overarching thesis.
2. The hierarchical **relationships** between topics and subtopics, main points and supporting evidence, abstract ideas and concrete details.

Sometimes you will create a working outline of your topic before you have gathered all your information, then will modify and rearrange the components as understand your subject better and think about the best presentation to your audience. At other times you may wait until you have gathered most or all of your information before you are able to develop an outline. The ultimate purpose of an outline is to help you write or present ideas in an organized manner that your audience can follow.

The most important ideas are labeled with Roman numerals I, II, III, etc. which are relatively of the same importance to each other. The indented subheadings A, B, C, etc., are subordinate to the Roman numeral but equally significant to other alphabetical letters.

I. Introduction/Thesis
II. Background of the problem
   A. History
      i. Pre 1900
      ii. From 1900 - 2000
      iii. From 2000 - present
   B. Current data
III. The scope of the problem
IV. First solution
   A. Advantages
      i. Case one
      ii. Case two
   B. Disadvantages
V. Second solution
   A. Advantages
   B. Disadvantages
VI. My solution
   A. Advantages
   B. Unresolved problems and disadvantages
VII. Future possibilities
Creating items in the outline

When you begin a new outline, you’ll find a sample topic and subtopic already in place.

![Figure 36: Blank outline](image)

You can delete these default items if you wish to. Or, to edit these existing items, simply click twice on the title (“Topic” or “Sub Topic”) in the outline. The first click selects the item and the second click puts the title into edit mode. When you finish editing, either press Enter or click outside of the edit box to save the changes.

First, a bit of terminology is helpful. As you are creating your outline, you will need to create both siblings and children of existing outline items. Siblings of item “A” would be “B”, “C”, “D”, etc. -- they are at the same indentation level and are subtopics of the same item in the outline. Children of item “A” would be “i”, “ii”, “iii”, “iv”, etc. -- they are subtopics of item “A”, indented right).

To add a new “child” item (subtopic) to the outline
→ Select a topic in the outline and click the green “+” button or press the Insert key. This adds a subtopic under the selected item. Alternatively, right-click on an item in the outline and choose “Add Subtopic (Child)” from the menu to create a subtopic.

To add a new “sibling” item to the outline
→ Select a topic in the outline and press the Enter key. This adds a sibling topic under the selected item. Alternatively, right-click on an item in the outline and choose “Add New Topic (Sibling)” from the menu.

Note: Clicking the green “+” button with no outline item selected will add a top-level (I, II, III, etc.) item.
Moving items in the outline

Use the left and right arrow buttons in the outline toolbar to change the indent level of an item in the outline. Use the up and down arrow buttons in the outline toolbar to change the order of subtopics (sibling items) under a topic item.

Figure 37: Outline

Some simple examples:

- Under Frogs → Body, we could reverse the order of the two subtopics “Legs” and “Head” by selecting “Legs” and clicking the down arrow button.
- To put “Birds” before “Frogs,” we can select “Birds” in the outline and click the up arrow button.

An example requiring several moves:

1. To put both “Frogs” and “Birds” under a new parent topic “Animals,” first create a new sibling item “Animals” by selecting “Birds” and pressing the Enter key (this gives you item “III. Animals”). Next, select the new “Animals” topic and press the up button twice to move it to the top (this gives you “I. Animals” followed by “II. Frogs” and “III. Birds”). Finally, select “Frogs” and click the right arrow to make it a subtopic of “Animals,” then do the same for “Birds.”
Deleting outline items
To remove an item from the outline, select the item and click the Delete button (a red “X”) in the outline toolbar. Alternatively, right-click on the item and choose “Delete” from the menu. Deleting a topic in your outline will delete all of the subtopics under that topic, so use this carefully.

Adding notecards to your outline
A powerful feature of the outline in NoodleBib is that you can add notecards that you have created to topics in your outline. Later, you can begin writing a draft of your essay by exporting your outline and notecards to a word processing program. You can also print your outline with your notecards included (see Printing the outline).

To begin, simply drag-and-drop a notecard or notecard pile from the Notecard Tabletop onto a topic or subtopic in your outline. Moving notecards into your outline does not remove the notecards from the tabletop; it only associates the notecard with the node in the outline. Dragging a notecard pile into the outline will add all of the notecards within that pile to the topic or subtopic in your outline. To distinguish notecards from topics and subtopics, notecards are represented by a small notecard icon, as shown:

Figure 38: Moving notecards into the outline

Once a notecard is associated with an item in the outline, you can move it around in the outline by clicking and dragging it to a different location in the
Working with Projects

Outline. Or, to remove it from the outline, click and drag the notecard out of the outline back onto the tabletop area.

You’ll notice that when a notecard has been added to the outline, a small black checkmark appears in the top-left corner of the notecard on the tabletop. This helps you keep track of which notecards you have already added to your outline.

In addition, clicking on a notecard within the outline causes the notecard on the tabletop (and its representation in the birds-eye-view) to flash blue so you can quickly identify its location on the tabletop.

Printing the outline

Printing the outline

→ Click the Print button in the outline toolbar.
→ Choose from three print options:
  → **Print outline with notecards**: Export as an HTML file, including the content of your notecards in line with the topics and subtopics of your outline. Outline numbering and HTML formatting in your notecards will be retained.
  → **Print outline without notecards**: Export just your outline as an HTML file, retaining your outline numbering.
  → **Convert outline to RTF**: Export as an RTF file that can be opened directly in Word.

**Important**: With the RTF option, notecards will be exported as plain text and images will be omitted. In addition, while outline subtopics will be properly indented, outline numbering is not currently retained.

→ If you chose to include the notecards in the export, choose the elements from the notecards that you wish to include in the exported file (quotation, paraphrase, my ideas, page numbers, etc.). By default, they will all be included. Unmark the checkboxes next to any elements that you wish to omit.
→ If you are exporting as a Web page, the Web page will open and you can use your browser’s File → Print mechanism to print the outline.
→ If you are exporting to an RTF file then depending on the browser you are using, the file download will either start automatically, or you will be prompted to click a link to start the file download. Save the RTF file to your computer and then open it in Word (or other word processor that supports the RTF file type).
Google Docs overview

Google Docs has quickly become the online word processing tool of choice at most schools and colleges, so we are confident that you will embrace the integration of Google Docs with NoodleBib.

When you click Paper in the NoodleBib navigation bar, a new document is created in your Google Docs account. That document is automatically tied to the NoodleBib project, so that you can return directly to the paper by clicking on the Paper button again.

When you share a NoodleBib project with a teacher, you have the option to share the Google Docs paper too. The teacher gains full edit access to the document and can give you feedback using Google’s comment tool directly on your working paper.

Creating a paper

To start authoring your research paper in NoodleBib:

→ Open a project and click Paper in the navigation bar (or in the Components area of the Dashboard screen).
→ A new browser window will open and prompt you to log in to your Google account. Enter your Google account information and click Sign in.

Note: This is a secure Google login screen. NoodleTools does not have access to the Google account information that you enter on this secure page and cannot retrieve your password.

→ If your login is successful, another Google Web page will prompt you to grant or deny access to NoodleBib. This will allow us to create a new document in your Google Docs account. Click Grant access.
→ The new Google Docs document will open and you may begin writing. Note that the title of the document is automatically set to match the title of your project, with your Personal ID in parentheses. For example, if you NoodleBib project is titled “E-waste management” and your ID is “SampleID”, the document will be titled “E-waste management (SampleID).”
→ Save your document and close the browser window containing Google Docs when you are done, or to continue working on other tasks in NoodleBib. The next time you click Paper in the NoodleBib navigation bar, this document will reopen. Only one Google Docs document can be associated with one NoodleBib project at a time.

**Sharing the paper with a teacher**

Detailed instructions for sharing a project can be found in *Sharing projects* in Chapter 6. In order for the paper to be shared along with the citations, notecards, and outline, there are three requirements:

1. The teacher that the student is sharing the project with must have saved a valid Google Account ID in his or her user profile (this can be done either by clicking the My Account link in NoodleBib, or from the Sharing Setup screens when defining a drop box).
2. The student must have created the paper through the links in NoodleBib as described above (not by opening Google Docs and creating a new document there).
3. The student must check the “Share my Google Docs paper” option on the Share Project screen.

![Figure 39: Sharing the Google Docs paper](image)
Collaborating on a paper

Detailed instructions for collaborating on a project can be found in Student collaboration in Chapter 6. In order for the paper to be accessible to all team members, there are two requirements:

1. Each team member must have a valid Google Account ID on record, as part of their user profile (Click the My Account link near the top of the screen to edit your user profile).*
2. The paper needs to have been created through the links in NoodleBib as described above (not by opening Google Docs and creating a new document there).

* On the Dashboard, if the words “(No Google ID)” appear for a student (under “Paper”), it means that the student did not have a Google Account ID defined in his profile when the project was shared with him. If the student needs access to the Google Doc associated with the project, he should click the “My Account” link near the top of the screen to edit his profile and add his Google Account ID. Then one of his team members who does have access to the paper can click the “Share Google Docs paper with these students” link in the Student Collaboration area to give the other student access to that paper.

Google Apps for Education

The NoodleBib account administrator has the option to enable students to use a Google Apps for Education account, rather than a personal Google account. To enable this option, the administrator should log into the school’s/district’s administration area and add the appropriate Google Apps for Education Domain in the NoodleBib Customization section.

Figure 40: Google Apps for Education administration option
Once this option is enabled, students will see a checkbox (checked by default) in their user profile (i.e., when they click the “My Account” link in NoodleBib) that allows them to specify whether or not they wish to use their Google Apps for Education account with NoodleBib.

**Figure 41: User profile with Google Apps for Education option**
Chapter 6: Working with Projects

Copying projects

You can create a duplicate copy of an entire project (source list, notecards and outline) in your own folder, or transfer a copy to another NoodleBib user. For instructions on how to copy individual citations, see Copying citations in Chapter 3.

Figure 42: Copying a project

To copy a project, click My Projects in the navigation bar, then click the Copy button (_Copy_) in the right-most column. Select my own personal folder if you want to duplicate the project in the same folder, or select another user's folder and enter a personal ID to transfer a copy of the project to another user.

To copy more than one project at a time, mark the checkboxes next to the projects you wish to copy and then click the Copy button at the bottom of the My Projects area.

Note that if you have work under two separate personal folders (for example, one free MLA Starter folder and one folder under a school’s subscription), the copy feature is a simple way of gathering all your work into a single folder.

Note: Only MLA Starter lists can be copied to a user’s free NoodleBib MLA Starter account.
Working with Projects

Note: If there is more than one user with the same personal ID, you may be prompted to identify the school or account type of the user before the transfer completes.

Sharing projects

If you are logging in through a school, library or classroom subscription, you have the option to share work. If a student shares a project, an instructor can view the source list, notecards, outline, and Google Docs paper. The teacher can give feedback next to individual citations and notecards, or provide comments and corrections in the Google Docs paper.

Note: A teacher or librarian can only view a student’s project if that student actively allows a project to be shared (described below in Student instructions).

Teacher instructions

Note: We recommend that teachers read both the Teacher instructions and Student instructions sections of this guide, so as to understand how sharing works on both sides.

To enable your students to share work with you, you will create one assignment drop box for each project you assign.

For example, you might create an assignment drop box titled “Smith 2010 ENG101 P3: Hamlet”. Your ENG101 period 3 students would use share their “Hamlet” project with you through this drop box.

Work submitted to you by your students is accessible from the Projects Shared with Me section of your personal folder. By creating one assignment drop box for each project you assign, student work is conveniently grouped for evaluation, as shown below.
Working with Projects

Figure 43: Projects Shared with Me (teacher’s view of shared projects)

Creating assignment drop boxes

→ Click My Projects in the navigation bar to view your personal folder.
→ Scroll to the bottom of the screen to view the Projects Shared with Me table.

Note: If your folder view does not include a Projects Shared with Me section, you did not select the I am a teacher or librarian option when you first created your personal folder. If your folder is empty, you can simply create a new folder using the correct option. If you have already composed a project within your folder that you wish to keep, contact your account administrator, who can convert your folder to a teacher’s folder through the subscription management area.

→ Click the Sharing Setup button.
→ On the Sharing Setup screen, first enter your name. This is the name that your students will see when you write comments to them, so it should be the name by which they refer to you in the classroom (e.g., “Mrs. Reeves” or “Debbie”).
→ Enter the new drop box name. The drop box name must be unique to the school(s) under your NoodleBib subscription but should also be simple enough for students to remember. Including the year and semester can be a good idea, to avoid getting it confused with a drop box name for the same project in a different year.
→ If there are other teachers or librarians who need to review and comment on the projects shared with you through this assignment drop box, you may enter their personal IDs under Additional recipients. They will see the shared projects in their Projects Shared with Me area, just as you do.
→ Enter your Google Account ID so that students who share projects with you will be able to share their Google Docs papers with you as well.
→ If there are any assignment-related links that you’d like students who share projects with this drop box to see, you can enter up to three of them. For each, enter a **Description** (e.g., “Assignment Calendar”) and the **URL**.

Some suggestions:
- An assignment calendar. For example, in Google Calendar, you can create a new calendar for a specific assignment by selecting **Settings \(\rightarrow\) Calendar Settings \(\rightarrow\) Calendars** and then clicking the **Create new calendar** button. After you create the calendar, go to the **Calendar details** screen and click the **HTML** button under **Private Address**. Copy and paste the link it gives you into the NoodleBib URL field.
- The online assignment sheet.
- A “suggested resources” Web page.
- A pathfinder or Webquest.
- A blog or wiki set up for the assignment.

→ **Click Create drop box.**
→ To add another assignment drop box, click the **Create a New Drop Box** button above the list of drop boxes on the **Sharing Setup** screen. If you make a mistake, you can edit an assignment drop box by clicking the assignment drop box in the list.
→ When you are done, click **My Projects** in the navigation bar to return to your personal folder.

In order for students to share projects with you, you must tell the students what **assignment drop box name** to use. For example, your assignment sheet might say: “Share your work with me using the assignment drop box name **Smith 2010 ENG101 P3: Hamlet.**”

Students can share their project either from either the **Dashboard** or **Bibliography** screen. Before you provide instructions to students, you may want to create a test student folder and share a project, so that you understand how the process works.

Projects that are shared with you are grouped in the **Projects Shared with Me** table by assignment drop box and then sorted by the date of last revision (i.e., projects that have been edited most recently will appear at the top). To improve readability when you have many classes sharing work with you, the individual
projects under each assignment drop box are hidden until you click the assignment drop box that you wish to view (or the “+” symbol next to it).

To identify the author of each project, the student’s username followed by his or her real name (as they entered it) appears in parentheses (under the Shared By column) in the far-right column. The first column of the table provides the description that the student gave to the project.

The status column can contain one of three values:

- **New**: You have not viewed or added comments to the project yet.
- **Viewed**: You have viewed the project, and the student/author has not made any revisions since that time.
- **Revised**: The student/author has made revisions since you last viewed or added comments to the project.

**Note**: We do not track whether the student has revised their Google doc paper since you last looked at it, so this status will only say Revised if the student has changed their notecards, outline, or source list.

To view a 30-day history of work done on a particular project, which includes specific times that the author logged in, added/edited/removed citations, added/edited/removed notecards, and more, mouse-over the status value and click the 30-day history log link in the pop-up window that appears.

The style (MLA, APA, or CHI) and level (Starter or Advanced) of each project is given, as well as the number of entries and number of notes (if the notecards feature is enabled). The last two columns indicate the date each was created and last modified.

You can remove a project that has been shared with you by clicking the Delete button (>Delete) next to the project (at the far-right). If you do so, you will not be able to view it unless the student shares the project with you a second time.

Projects shared with you are opened in read-only mode – you can view but not modify the student’s citations, notecards, and outline. There is one exception to this -- if a student has shared a Google Docs paper as part of the project, you do have full edit privilege on that document, allowing you to write comments and/or corrections directly on the document.

Click a project’s description to open it. On the Bibliography screen, display the form used to create the citation by clicking the View button (>View) next to the
citation you wish to see. When you see exactly what information the student entered into each field, you will be able to analyze what a student doesn’t understand or find mistakes in style.

If the notecards feature is enabled, a Show link in the “Notecards” column allows you to view notecards associated with a particular entry. To view all notecards that the student has created, click the Show/hide all link in the Notecard display options bar near the top of the screen.

Although you cannot make changes to the citations, notecards, or outline, you have the ability to add comments. Students will appreciate having a chance to improve or correct their work based on your feedback before they submit their final products.

Figure 44: Teacher’s view of a shared project
Providing feedback on citations and notecards to your students

→ Open the project by clicking on the project’s description under Projects Shared with Me.
→ Click Bibliography in the navigation bar.
→ Enter a comment into the comment box below the citation or notecard that you wish to provide feedback about and then click the Submit button.
→ A Select comments from the comment database link underneath each notecard comment box allows you to select (and customize) predefined comments from our notecard comment database.
→ Your comment will be displayed to the student directly within the source list. With a large “comments” icon on the left side (pictured below), comments are easily visible as the instructor or student scans the source list.
→ The student’s personal folder will display a message to indicate that new comments have been added since the last time the student viewed the project.

Archiving old assignment drop boxes

Assignment drop boxes from previous school years can be archived (as opposed to deleting them completely). An archived drop box will not show up in your “Projects Shared with Me” area, nor can students share work with it. This eliminates clutter from your screen and students will not be confused seeing drop boxes from previous years.

Archiving an assignment drop box:

→ Click the Sharing Setup button on the My Projects screen.
→ Mark the checkboxes next to the drop boxes you wish to archive.
→ Click the Archive button.
You can always unarchive a drop box to review student work from past classes, to find exemplars to show current students, or to add to their own portfolio. On the Sharing Setup screen, simply mark the checkbox next to the archived project and click the Restore button.

**Student instructions**

Your teacher may ask you to share your project. This gives your teacher the ability to look at your work and send you helpful feedback. On your assignment sheet, your teacher will tell you the assignment drop box name to use when sharing your project.

Sharing a project

- Open the project you wish to share and then (a) click the Share this project with my teacher link on the Dashboard screen or (b) click the Share button at the top of the Bibliography screen.
- Enter the assignment drop box name where prompted.

Note: The name will auto-complete as you begin to type, so once you see the right one, just select it from the dropdown list.
→ Enter your name in the **First and Last Name** field so that your instructor will know who you are (he or she may not recognize your personal ID).
→ If your teacher has asked you to author your paper in Google Docs and share that as well, mark the checkbox next to “Share my Google Docs paper.”
→ Click **Share Project**.
→ When you return to the **Dashboard** for your project, information about the assignment drop box(es) the project is shared with appears in the **Sharing** section. On the My Projects screen, the project you shared will have a checkmark in the **Shared** column.

![My Projects](image.png)

Figure 46: Shared projects (one with new comments)

When a teacher views your shared project and writes comments to you, you will notice that the checkmark displayed in the right-hand **Shared?** column of your personal folder is replaced with a yellow “new” indicator (NEW). Open the project to view the new comments. Your teacher’s comments appear directly below the relevant citation or notecard. If there is more than one comment on a particular citation or notecard, the most recent comment is displayed at the top.

If you have many notecards, it can be difficult to find notecard comments when they are all displayed on the **Bibliography** screen. To only display notecards on which your instructor has written comments, click the **Show only notecards that have comments** link in the **Notecard display** bar near the top of the screen.

![Figure 47: Teacher’s comment displayed below a student’s citation](image.png)

Following each comment, you will find the name of the teacher who wrote the comment, as well as the date and time the comment was written.
When you have read and acted on the comment, you can permanently remove the comment from your view by clicking the **Delete comment** link.

**Note:** Even if they are not removed via the **Delete comment** link, comments will not appear in RTF or HTML files generated by the **Print** option in NoodleBib.

**Student collaboration**

If you wish to work together with classmates on a project, you will need to use NoodleBib’s student collaboration feature. The feature is only available if your personal folder was created under a teacher’s or school’s subscription. It is not available from a free NoodleBib MLA Starter folder, an individual subscription folder, or a folder created through MyCompLab.

**Adding Collaborators**

You can add collaborators to a project at any time.

**Adding a collaborator**

→ From the **Dashboard** screen, click the **Add/remove students** link under the heading “Student Collaboration.”
→ On the **Collaboration Setup** screen, type in the Personal ID of the student that you wish to add as a collaborator. As you type the first few letters of the ID, an auto-complete dropdown list will appear, to assist you with typing the ID correctly.
→ If you wish to add more than one collaborator, click the **Add More** link and type the IDs for each one.
→ Click the **Save** button to save your changes, then click the **Back to Project** button to return to the project dashboard.
When collaborators have been added successfully to a project, you will see them listed on the Dashboard screen in the Student Collaboration area.

**Figure 48: Student collaboration details on the Dashboard**

<table>
<thead>
<tr>
<th>Student Collaboration</th>
<th>ID</th>
<th>Bibliography</th>
<th>Notecards/Outline</th>
<th>Paper</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>debbie_student</td>
<td>![Checkmark]</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>damon_student!</td>
<td>![Checkmark]</td>
<td>✔</td>
<td>✔</td>
<td>(No Google ID)</td>
</tr>
</tbody>
</table>

The sources, notecards, and outline of a project are always accessible to all members of a collaborative project. However, the Google Docs paper may or may not be. Under “Paper” in the Student Collaboration area, you may see one of the following:

1. **Checkmark**: The student has access to the Google Docs paper, assuming the Google Account ID she provided in her user profile was valid.
2. **Blank**: No team member has started a Google Docs paper yet.
3. **(No Google ID)**: This will be displayed if the student had not provided her Google Account ID in her profile prior to being added as a collaborator to the project. If the student would like to access the Google Docs paper, she needs to (1) click the “My Account” link near the top of the screen in NoodleBib and check to see that she has provided her Google Account ID there, then (2) ask a team member who does have access to the paper already to click the “Share Google Docs paper with the students” link in the Dashboard Student Collaboration area.

If you are a member of a collaborative project, you will see the project in the My Projects list (with Projects selected in the navigation bar). The project shows up like any other project that you create, but you will see a checkmark in the Collaborating? column of the list. A collaborative project can be shared with an assignment drop box just like any other project, so there can potentially be checkmarks in both the Shared? and Collaborating? columns.
Working on a collaborative project

As you work on a collaborative project, other students on your team may log in to contribute work or make changes. When a team member opens the same project you are working on, a status box appears at the top-right of your screen titled **Collaborators Online**. The status box will inform you when team members join or leave the project. If you mouse-over the status box, you can view the users who are online with you.

More importantly, as team members make changes to the project, your own view will update to reflect those changes. A gray “Syncing changes...” status box will display under the blue **Collaborators Online** status box as your screen changes. You’ll notice this happen most often on the **Notecards** screen, where it is crucial that what you see on your screen is up-to-date. For example, a teammate might place several notecards in a pile. You might have intended to move one of those notecards into a different pile, so the software will show that change in the **Notecards** screen as you mouse-over or click on a notecard to make your own changes. This automatic sync continually provides the entire team with the most recent version of the project.
For a demonstration of this, please view the online tutorial here:

http://www.noodletools.com/noodlebib/tutorials/collaboration/

Since it’s not crucial to see a new source entry in real time, we don’t slow down your work by updating your source list screen immediately. If a teammate adds a source, you will see that change the next time your Bibliography screen loads.

**Teacher’s view of a collaborative project**

If you are a teacher and a collaborative project is shared with your assignment drop box, the project shows up in the Projects Shared with Me area of your Projects screen just like any other project. However, the Shared By column indicates that it is a collaborative project and displays the number of students involved.

Mouse-over the link in that column (“3 students” in the screenshot below) to display the IDs and names (if known) of the team members.

![Figure 51: Collaborative project in Lists Shared With Me](image)

In keeping with good assessment practices for collaborative work, we help you monitor individual student contributions. For example, if you look at a citation in the source list, an additional “Creator” column displays the student who created that citation.

![Figure 52: Citation indicates creator in a collaborative project](image)
Similarly, the creator of a notecard is displayed as part of the “History” field.

**Figure 53: Notecard indicates creator in a collaborative project**

When you add a comment (on a notecard, citation, or a general comment on the project) to a collaborative project, all team members associated with the project will see the comment and have the opportunity to make the necessary changes.

**Deleting a collaborative project**

If you are a collaborator on a project, selecting the project and deleting it from the **My Projects** list simply removes you as a collaborator on that project. The project will still remain visible to your teammates.

**Note:** If you accidentally delete a collaborative project from your folder, ask one of your teammates to re-add you as a collaborator to the project.

**E-Mailing projects**

You can e-mail the RTF version of your source list and an HTML version of your notecards and outline to yourself or someone else. The recipient will be able to open the source list in a word processing program. The HTML versions of the notecards and outline can be opened in any Web browser. The recipient will not be able to log in to your personal folder or change your master project in any way – only a copy of your work is sent. There is also no way for the recipient to import the RTF version of your source list into their own personal folder. However, you can share an editable copy of your project with another NoodleBib user (see **Copying projects** in Chapter 6).

E-mailing a project to someone

→ From the **Bibliography** screen, click the **Email** button.
→ Enter your name in the first field.
→ Enter the recipient’s e-mail address in the next field.
→ If your source list contains notecards or an outline, additional checkboxes allow you to attach HTML versions of those.
→ Click **Send** to e-mail the source list and other project components.
Note: The Google Docs paper is not currently included in the e-mail that you send. If you want to e-mail a document to someone, log in to your Google Docs account and e-mail it from there.

Merging projects

Two or more projects in your personal folder can be merged into a single project. As a safeguard, the original projects you select to merge will also remain in your personal folder unchanged. The new merged project will be added to your folder, identified by a new description that you provide.

Note: Merging an MLA Starter project with an MLA Advanced project results in a new MLA Advanced project.

To merge projects
→ On the My Projects screen, check the boxes next to the projects that you wish to merge.
   Restriction: All projects must contain source lists of the same style.
→ Click the Merge button at the bottom of the screen.
→ Enter a brief description for the new, merged project.
→ If you would like to prevent duplicate citations from appearing in the new source list, mark the checkbox next to Remove duplicate citations from merged project.
→ If the original projects have notecards, decide whether or not you would like those notecards to be transferred to the merged project. By default, the Include notecards from original projects (if any) in merged project option is checked.
→ Note: Checking both the “remove duplicates” and the “include notecards” options can potentially cause unwanted results. If there are duplicate citations that have different sets of associated notecards, then only one set of those notecards will be transferred to the merged list.
→ Multiple outlines from the selected projects cannot be merged. Under “Include outline from...” choose which project’s outline you wish to include in the new merged project (if any).
→ Click Merge.
**Deleting projects**

One or more projects can be deleted by checking the boxes to the left of the projects in the **My Projects** table, then clicking the **Delete** button below the table. The selected projects will no longer appear in your folder.

As a safeguard, we do not remove the deleted projects from our database immediately. If you want to recover a project that you deleted, click the **Undelete** button at the bottom-right corner of the **My Projects** table.

**Note:** If select a collaborative project and delete it from the **My Projects** list, the project is not deleted at all – you are simply removed as a collaborator from that project. The project will still remain visible to your teammates. If you accidentally delete a collaborative project from your folder, ask one of your teammates to re-add you as a collaborator to the project.

**Archiving projects**

While it may make sense to delete some projects that you know you no longer need, you may also decide to keep certain projects for future reference or as part of your academic portfolio. As your projects pile up, it may become more difficult to find current work and can even slow down the **My Projects** screen loading time. To solve this, you should archive old projects.

Projects can be archived via the **Archive** button on the **My Projects** screen. Archived projects are displayed in an “Archived Projects” area (hidden by default, but expandable as shown in the screenshot):
Archiving a project has no effect on its “shared” or “collaborating” status. A teacher that you have shared the project with will still be able to view and comment on the project. Team members of a collaborative project that you archived will continue to see and have full access to edit the project.

If you want to continue working on an archived project, you will likely want to move it back into the regular list of your projects by marking the checkbox next to the project and clicking the Unarchive button.

**Renaming projects**

To rename a project in your personal folder, click the Rename button (_rename_) next to the project (far-right column in the table). You will be prompted to enter a new description for the project. Each project in your folder should have a unique name.
Chapter 7: Troubleshooting

Overview

If you need assistance, please follow these steps:

1. Double-check the Common issues section of this chapter.

2. If you are unable to access the Web site at all and you believe the issue may be on our side, check the NoodleTools Server Status site to determine if (and why) the server is offline:

   http://www.noodletools.info/

3. If you have a “How do I cite...?” question, search the Knowledge Base to see if your question has already been answered:


   If not, click the “Have a Question?” link next to one of the citations in your source list to get personal assistance from NoodleTools experts.

4. If you have a question about how to use NoodleBib, or about the status of your subscription, submit a ticket in the NoodleTools Support Center:

   http://www.noodletools.com/helpdesk/
Common questions

Subscribing

“How much does subscribing cost?”
Subscription pricing is all available on the Web site. From the home page, click Subscription Info (under “NoodleBib”). Then click Learn more next to the appropriate subscription license type to view subscription pricing. If you are subscribing for a single campus, you can generate and print an e-quotation. If your school is a member of a consortium or purchasing cooperative that we work with, you can contact us for a custom quotation. Likewise, if you are subscribing for an entire district or consortium, e-mail us for information.

“I submitted a subscription request for my school but it has been over 24 hours and I haven’t received any response.”
New subscription requests are processed at least once a day (usually more often), so if you have not heard back from us within 24 hours after submitting the subscription request form, you should contact us. Your account activation e-mail may have been caught in a spam filter, or the e-mail address that was provided to us may have had a typo. Submit a ticket in the NoodleTools Support Center or call us to report the issue.
Using NoodleBib

“How do I enable cookies and JavaScript in my browser?”

NoodleBib requires that both JavaScript and cookies be enabled in your browser. Depending on your platform (PC or Mac) and the browser you are using, the procedure for turning these options on varies slightly.

**Note:** We do not store any personal information in the cookies that we create. Cookies maintain the state of your NoodleBib session as you traverse from screen to screen.

To enable JavaScript:

- **Internet Explorer (PC)**
  Select “Internet Options...” from the “Tools” menu. Click the “Security” tab and then click the “Custom Level” button. Find the “Scripting” category and click “Enable” under “Active Scripting.”

- **Firefox**
  **PC:** Select “Options...” from the “Tools” menu. Click the “Content” icon at the top of the Options window and mark the checkbox next to “Enable JavaScript.”
  **Mac:** Select “Preferences...” from the “Firefox” menu. Click the “Content” icon at the top of the Options window and mark the checkbox next to “Enable JavaScript.”

- **Safari**
  **PC:** Select “Preferences...” from the Settings menu (gear icon at top-right corner of browser). Click the “Security” icon at the top of the Preferences window and mark the checkbox next to “Enable JavaScript.”
  **Mac:** Select “Preferences...” from the “Safari” menu. Click the “Security” icon at the top of the Preferences window and mark the checkbox next to “Enable JavaScript.”

To enable cookies:

- **Internet Explorer (PC)**
Troubleshooting

Select “Internet Options...” from the “Tools” menu. Select the “Privacy” tab. **Option 1:** Click the “Sites” button. Type “www.noodletools.com” into the field and click the “Allow” button. **Option 2:** Click the “Advanced...” button. Make sure the “Override automatic cookie handling” check box is checked. Select the “Accept” option button under “First Party Cookies” and under “Third Party Cookies.”

- **Firefox**
  - **PC:** Select “Options...” from the “Tools” menu. Click the “Privacy” icon at the top of the Options window and mark the checkbox next to “Accept cookies from sites.”
  - **Mac:** Select “Preferences...” from the “Firefox” menu. Click the “Privacy” icon at the top. **Option 1:** Choose “Remember history” from the “Firefox will...” dropdown menu. **Option 2:** Choose “Use custom settings for history” from the “Firefox will...” dropdown menu, then mark the checkbox next to “Accept cookies from sites.”

- **Safari**
  - **PC:** Select “Preferences...” from the Settings menu (gear icon at top-right corner of browser). Click the “Security” icon at the top of the Preferences window and mark the checkbox next to either “Accept cookies: Always” or “Accept cookies: Only from sites I visit.”
  - **Mac:** Select “Preferences...” from the “Safari” menu. Click the “Security” icon at the top of the Preferences window and mark the checkbox next to either “Accept cookies: Always” or “Accept cookies: Only from sites I visit.”

“Why am I getting a Page cannot be displayed or Page expired error?”

Do not use the browser’s back or forward buttons while you are using NoodleBib. Since NoodleBib is a dynamic Web site (pages are created dynamically using information from the database and data that you enter), the browser’s navigation buttons should not be used -- they will often result in a “Page cannot be displayed” or “Page expired” error screen.

If you do accidentally use the browser’s back/forward buttons and get an error page, click the browser’s “reload” button to return to NoodleBib.
Troubleshooting

“When I click on the help links next to the citation fields in NoodleBib, nothing happens.”

It is likely that you have a pop-up blocker installed on your computer. The most common pop-up blockers are the ones that come with add-on browser toolbars (like Yahoo’s and Google’s toolbars), and the Internet Explorer pop-up blocker that is enabled by default in Windows. Disable any such pop-up blockers for the NoodleTools.com domain.

If you do not have a pop-up blocker on your computer, check to see if the pop-up window is behind another window. Minimize the application windows on your desktop to be sure there isn’t a browser window hiding behind them.